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ВВЕДЕНИЕ 

 

 
 

Известно, что выполнение чертежей является достаточно сложным и трудоемким процессом, требующим специаль-
ных знаний и умений. Например, только на оформление графической документации отводится до 70 % всех трудовых 
затрат. Для облегчения указанной разновидности графической деятельности используются различные приспособления, 
приборы и устройства. Однако они не удовлетворяют современным требованиям быстрого создания качественной графи-
ческой продукции. На смену традиционным средствам малой механизации графической деятельности пришли персо-
нальные компьютеры. 

Современными средствами выполнения чертежей на персональных компьютерах являются специализированные 
графические системы автоматизированного проектирования – CAD системы. На этапе развития компьютерной графики и 
широкого использования ее в различных видах деятельности достаточно важным для нас представляется вопрос, связан-
ный с применением в учебном процессе CAD систем. 

Создание чертежей средствами компьютера отличается от традиционных "ручных" способов, так как пользователю 
необходимы знания возможностей того или иного программного продукта и умения осуществлять необходимые дейст-
вия, связанные с графическими построениями на базе имеющегося профессионально значимого теоретического материа-
ла. 

Современные системы автоматизированного проектирования разделяются на так называемые "двухмерные" (2D) и 
"трехмерные" (3D). Принцип работы с ними значительно отличается друг от друга. Предпочтение отдается программам, 
позволяющим осуществлять так называемое "твердотельное моделирование" (ЗD). При этом на первое место выдвигается 
создание объемной формы объекта, а непосредственное выполнение чертежей на ее основе является следствием этого 
процесса. 

Рынок программной продукции постоянно пополняется различными по своим функциональным возможностям система-
ми. Например, для выполнения чертежей машиностроительного профиля применяются: AutoCAD, ADEM, CADDS 5, 
UNIGRAPHICS, MicroStation, Pro/ENGINEER, CADdy "Машиностроение", Cimatron, Imagineer Technical, T-FLEX и др. [1]. 
Указанные программные продукты имеют общие особенности: 

1. Наличие базы данных, позволяющей хранить информацию и выполнять проект различными способами. 
2. Быстрое изготовление чертежей с возможностью получения ортогональных проекций на основе аксонометриче-

ских (3D). 
3. Автоматическое изменение изображенного после изменения значений размеров. 
4. Наличие слоев видимости и реалистическое цветотеневое изображение проектируемого объекта. 
5. Расчет объема, массы и других подобных величин проектируемого изделия. 
6. Выполнение сборочных чертежей. 
7. Вывод чертежно-графической информации на плоттер и принтер. 
8. Передача данных в автоматизированную систему управления производством. 
Принимая во внимание цели и задачи обучения, следует учитывать некоторые психологические аспекты графиче-

ской деятельности, связанные с отображением мысленно созданного образа объекта. Пространственное представление 
человека всегда вначале мысленно создает некую объемную модель объекта, которая является основой для преобразова-
ния ее в ортогональные проекции. Идеология двухмерного проектирования заключается в выполнении изображений на 
основе воображаемого человеком трехмерного объекта с помощью набора различных линий и функций. Каждая проекция 
детали строится отдельно в проекционной связи и в данном случае, автоматизируется лишь сам процесс получения изо-
бражения и проставления размеров. 

Другой подход достаточно универсален, так как основан на изначальном создании некоторой объемной (аксономет-
рической или перспективной) модели изделия, на основе которой автоматически получаются необходимые виды, разрезы 
и сечения [2]. Он в большей степени автоматизирует графическую деятельность и учитывает психологические особенно-
сти создания образа изделия. 

Необходимость развития пространственного представления студентов требует такого подхода, при котором на на-
чальном этапе изучения программных продуктов желательно использование двухмерных систем либо их двухмерных 
модулей. После выполнения несложных ортогональных проекций деталей можно переходить к твердотельному модели-
рованию. 

 
 
 
 
 
 
 
 
 
 
 
 



 

1. ОСНОВЫ КОМПЬЮТЕРНОЙ ГРАФИКИ 
 

 
 

1.1. ПОСТРОЕНИЕ ОБЪЕКТОВ 
 

1.1.1. Объектная привязка координат 
 

Объектная привязка – наиболее быстрый способ точно указать точку на объекте, не обязательно зная ее координаты, 
а также построить вспомогательные линии. Например, объектная привязка позволяет построить отрезок от центра ок-
ружности, от середины сегмента полилинии, от реального или видимого пересечения объектов. Объектную привязку 
можно задать в любой момент, когда AutoCAD ожидает ввода координат точки. В этом случае указанный режим приме-
няется только к следующему выбранному объекту. Кроме того, имеется возможность установки одного или нескольких 
режимов объектной привязки в качестве текущих [3]. Таким образом, активизация объектной привязки может осуществ-
ляться двумя способами:  

1)  разовые режимы объектной привязки, действующие при указании только текущей (одной) точки;  
2) текущие режимы объектной привязки, действующие постоянно до их отключения.  
Режимы объектной привязки выбираются на плавающей панели инструментов Object Snap (рис. 1).  

 
 

 
 

Рис. 1. Панель инструментов объектной привязки 

 
Можно для выбора ключей объектной привязки использовать контекстное меню, которое вызывается щелчком пра-

вой кнопки мыши в любом месте области рисования при нажатой клавише Shift. В режиме объектной привязки точка 
помечается маркером; его форма зависит от используемого режима, имя которого появляется возле точки в виде подсказ-
ки.  

 

Отслеживание. Temporary Tracking Point – точка отслеживания. Отслеживание применяется для наглядного указа-
ния точек, связанных с другими точками рисунка. Оно может использоваться в любой момент, когда AutoCAD запраши-
вает координаты точки. После включения режима Temporary Tracking Point и указания первой точки AutoCAD включает 
ортогональный режим ORTHO и ставит выбор следующей точки в зависимость от положения вершины вертикальной или 
горизонтальной траектории, проведенной из первой точки. Для смены направления траектории необходимо вернуть ука-
затель мыши в первую точку, а затем перемещать его в нужном направлении (вертикальном или горизонтальном). На-
правление траектории определяет, какая из координат первой точки (x или y) сохраняется неизменной, а какая получает 
новое значение. Если резиновая линия траектории направлена по горизонтали, изменяется координата x, если же по вер-
тикали, – изменяется координата y. После выбора второй точки и нажатия клавиши Enter для завершения отслеживания 
AutoCAD фиксирует точку, находящуюся на пересечении воображаемых ортогональных линий, проходящих через две 
выбранные точки.  

Использование режима Temporary Tracking Point – наиболее легкий способ обнаружения центральной, точки прямо-
угольника. Чтобы включить режим отслеживания, необходимо щелкнуть мышью по пиктограмме Temporary Tracking 
Point на стандартной панели инструментов, а затем указать центры вертикальной и горизонтальной сторон прямоуголь-
ника. Режим Temporary Tracking Point в комбинации с прямым вводом расстояния может использоваться для размещения 
объектов или текста на заданном расстоянии от другого объекта. После включения режима отслеживания AutoCAD не 
отображает выбираемые точки до тех пор, пока этот режим не будет отключен нажатием клавиши Enter. Поэтому для 
отслеживания можно использовать любое количество точек. 

 

Смещение. Snap From – смещение. Режим объектной привязки From отличает-
ся от остальных тем, что позволяет установить временную базовую точку для по-
строения следующих точек. Обычно режим смещения используется в сочетании с 
другими режимами объектной привязки и относительными координатами, посколь-
ку довольно часто требуется определить точку, у которой известны координаты от-
носительно некоторой точки уже нарисованного объекта.  

 

Конечная точка. Snap to Endpoint – привязка к ближайшей из конечных точек 
объектов (отрезков, дуг и т.п.), рис. 2. В случае пространственного моделирования, 
если объект имеет ненулевую высоту, допускается привязка к его нижней и верхней 
границам. В режиме Endpoint привязка может производиться к границам трехмерных 
тел и областей, например к конечной точке (вершине) параллелепипеда.  

Средняя точка. Snap to Midpoint – привязка к   средним точкам объектов (отрезков, дуг и т.п.), рис. 3. Привязка для бес-
конечных прямых и лучей производится к первой из определяющих их точек. Для сплайнов и эллипсов в режиме Midpoint 
осуществляется привязка к точке объекта, расположенной на равных расстояниях от начальной и конечной точек. В случае 
пространственного моделирования, если отрезок или дуга имеет ненулевую высоту, можно осуществлять привязку к середи-

Рис. 2. Построение с  
привязкой к конечным  

точкам 



 

Рис. 6. Построение с 
привязкой к центру 

нам верхней и нижней границ объекта. Режим Midpoint позволяет также производить привязку к 
границам трехмерных тел и областей. 

 

Пересечение. Snap to Intersection – привязка к точкам пересечений объектов (отрезков, 
окружностей, дуг, сплайнов и т.п.), рис. 4. В случае пространственного моделирования в 
режиме Intersection допускается привязка к угловым точкам объектов, имеющих ненулевую 
высоту выдавливания. Если два таких объекта с пересекающимися основаниями имеют оди-
наковое направление выдавливания, можно произвести привязку к пересечениям их верхней 
и нижней границ. Если высоты объектов различны, точка пересечения определяется объек-
том с меньшей высотой. Привязка к пересечениям дуг и окружностей, входящих в блоки (в 

них группы объектов рассматриваются как единый объект), производится только в том случае, 
если масштабы вставки блока по осям равны. К пересечениям отрезков внутри блока сказанное 
не относится. Можно осуществлять привязку к пересечениям границ областей и кривых, за ис-
ключением криволинейных границ трехмерных тел. Режим Intersection позволяет выполнить 
привязку к точке воображаемого пересечения двух любых объектов. Если в прицел попадает 
только один из объектов, AutoCAD предлагает указать второй и производит привязку к точке, в 
которой эти объекты пересекались бы при их естественном удлинении. Режим расширенного 
пересечения Extended Intersection включается автоматически при выборе режима объектной 
привязки Intersection.  

 

Предполагаемое сечение. Snap to Apparent Intersection – привяз-
ка к точке видимого на экране предполагаемого пересечения (рис. 5). 

Режим Apparent Intersection ищет точку пересечения двух объектов, которые не имеют явной 
точки пересечения в пространстве. Режим предполагаемого пересечения обеспечивает эффек-
тивную работу с границами областей и кривыми, но не работает с границами и углами трех-
мерных тел. Если объекты находятся в одной плоскости, то описываемый режим повторяет 
возможности режима Intersection. Режим Apparent Intersection включает в себя два отдельных 
режима: собственно Apparent Intersection и расширенное кажущееся пересечение Extended 
Apparent Intersection. Привязка в этих режимах может применяться к пересечениям границ об-
ластей и кривых, кроме криволинейных границ трехмерных тел. В режиме Apparent Intersection 
выполняется привязка к точке пересечения двух объектов, которые реально не пересекаются в 
трехмерном пространстве, но на текущем виде выглядят пересекающимися. Если существует 
несколько точек кажущихся пересечений, AutoCAD производит привязку к пересечению, рас-
положенному ближе ко второй точке выбора. Режим Extended Apparent Intersection позволяет осуществить привязку к 
точке воображаемого пересечения двух любых объектов. Если в прицел попадает только один объект, AutoCAD предла-
гает указать второй и производит привязку к точке, в которой эти объекты пересекались бы при их естественном удлине-
нии. Режим Extended Apparent Intersection включается автоматически при выборе режима объектной привязки Apparent 
Intersection; при этом он активен тогда, когда в прицел попадает только один объект и другие режимы объектной привяз-
ки отключены. Оба указанных режима могут использоваться как для разовой привязки точки, так и в качестве текущих 
режимов привязки.  

 

Продолжение объекта. Snap to Extension – привязка к продолжениям объектов. Она необхо-
дима в том случае, когда при построении объектов требуется использовать линии, являющиеся вре-
менным продолжением существующих линий и дуг. Данный режим можно совмещать с режимом 
Apparent Intersection с целью осуществить привязку к точке воображаемого пересечения объектов, 
для чего нужно медленно перемещать указатель мыши рядом с конечной точкой отрезка или дуги. 
Появляющийся символ "плюс" (+) свидетельствует о захвате конечной точки отрезка или дуги. По-
сле этого следует провести указатель вдоль временной линии продолжения. Если включен режим 
привязки Apparent Intersection, можно найти точку пересечения воображаемого продолжения отрез-
ка или дуги с другим объектом.  

 

Точка центра. Snap to Center – привязка к центру дуги, окружности или эллипса (рис. 6). 
При использовании режима Center необходимо указывать мышью на линию дуги, окружности или эллипса, а не на их центр. 
В этом режиме можно осуществлять привязку и к центрам окружностей, являющихся частью тел и областей. При привязке к 
центру нужно выбирать видимую часть дуги, окружности или эллипса. 

Квадрант .Snap to Quadrant – привязка к ближайшему квадранту (точке, расположенной под углом 0, 90, 180 или 
270° от центра) дуги, окружности или эллипса. Расположение точек квадрантов окружностей и дуг определяется текущей 
ориентацией ПСК. Если дуга, окружность или эллипс входят в блок, вставленный с ненулевым углом поворота, точки 
квадрантов ориентируются в соответствии с этим углом.  

 

Касательная. Snap to Tangent – привязка к точке на дуге, окружности, эллипсе или плос-
ком сплайне, принадлежащей касательной к другому объекту (рис. 7). С помощью режима объ-
ектной привязки Tangent можно, например, построить по трем точкам окружность, касающуюся 
трех других окружностей. При выборе точки на дуге, полилинии или окружности в качестве 
первой точки привязки в режиме Tangent автоматически активизируется режим задержанной 
касательной Deferred Tangent, который может быть использован для построения окружностей по 
двум и трем точкам, при формировании окружности, касательной к трем другим объектам. Ре-
жим Deferred Tangent неприменим к эллипсам и сплайнам. Если необходимо построить отрезок, 
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касательный к эллипсу или сплайну, функция привязки будет выдавать ряд точек на эллипсе или сплайне, через которые 
может быть проведен касательный отрезок, но положения этих точек непредсказуемы. Режим привязки Tangent работает 
с дугами и окружностями, входящими в блоки, только если масштабные коэффициенты вставки блока по осям равны 
единице, а направления выдавливания объектов параллельны текущей ПСК. Для сплайнов и эллипсов вторая указанная 
точка должна лежать в той же плоскости, что и точка привязки. При совместном использовании режимов привязки From 
и Tangent для построения объектов, отличных от касательных отрезков к дугам и окружностям, первая точка объекта ле-
жит на касательной к дуге или окружности, проведенной через последнюю указанную в пространстве рисунка точку.  

 

Нормаль. Snap to Perpendicular – привязка к точке объекта, лежащей на нормали к другому 
объекту или к его воображаемому продолжению (рис. 8). Режим Perpendicular может использо-
ваться для таких объектов, как отрезки, окружности, эллипсы, сплайны и дуги. Если режим при-
вязки Perpendicular применяется для указания первой точки отрезка или окружности, происходит 
построение отрезка или окружности, перпендикулярных выбранному объекту. Если должна быть 
указана вторая точка отрезка или окружности, AutoCAD производит привязку к точке объекта, 
которая принадлежит нормали, проведенной к первой указанной точке. Когда описываемый ре-
жим используется для сплайнов, функция выполняет привязку к точке на сплайне, через которую 
проходит вектор нормали, проведенный из указанной точки. Вектором нормали в любой точке 

сплайна является вектор, перпендикулярный касательной в данной точке. Если указанная пользователем точка лежит на 
сплайне, то в режиме Perpendicular она будет считаться одной из возможных точек привязки. В некоторых случаях при 
работе со сплайнами положение точек привязки оказывается неочевидным. Кроме того, для некоторых сплайнов в дан-
ном режиме объектной привязки таких точек может вообще не существовать.  

 

Параллель. Snap to Parallel – привязка объектов к параллелям. Эта привязка удобна при необходимости построения 
прямолинейных объектов, параллельных имеющимся прямолинейным сегментам. В области прицела должен находиться 
только один отрезок. Появление символа параллельной привязки свидетельствует о выборе отрезка. Теперь следует мед-
ленно перемещать указатель мыши из начальной точки в направлении, приблизительно параллельном выбранному объ-
екту. При этом появляется линия отслеживания, отображаемая пунктиром. Ее положение и ориентация определяются 
заданной начальной точкой и выбранным объектом. Чтобы в качестве конечной точки создаваемого параллельного от-
резка использовать точку пересечения линии отслеживания с имеющимися объектами, можно включить режимы привяз-
ки пересечения Intersection и кажущегося пересечения Apparent Intersection. 

 

Точка вставки. Snap to Insert – привязка к точке вставки блока, формы, текста, атрибута (содержащего информацию 
о блоке) или определения атрибута (задающего характеристики атрибута). При выборе атрибута, входящего в блок, 
AutoCAD производит привязку к точке вставки атрибута, а не блока. Таким образом, если блок не содержит ничего, кро-
ме атрибутов, привязка к точке вставки самого блока возможна только в случае, если эта точка совпадает с точкой встав-
ки одного из атрибутов.  

 

Точечный элемент. Snap to Node – привязка к объекту «точка», сформированному командой POINT. Точки, входя-
щие в определение блока, после его вставки могут служить узлами привязки.  

 

Ближайшая точка. Snap to Nearest – привязка к точке на объекте, которая является ближайшей к позиции перекре-
стья.  

 

Отмена объектной привязки. Snap to None – режим отмены всех текущих и разовых режимов объектной привязки.  
Выбор режимов привязки. Object Snap Setti ngs – установка режима текущей объектной привязки на вкладке Object 

Snap диалогового окна Drafting Settings (рис. 9).  

 
 

Рис. 9. Диалоговое окно установки  
режима текущей объектной привязки 

 
Это окно также загружается из падающего меню Tools>Drafting Settings... или из контекстного меню, которое вызы-

вается при щелчке правой кнопки мыши по кнопке OSNAP в строке состояния и последующем выборе пункта Settings. 
Если требуется несколько раз подряд произвести привязку определенного типа (например, к конечным точкам или цен-
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трам), можно задать один или несколько текущих режимов объектной привязки. Следует иметь в виду, что режим объ-
ектной привязки From не может быть установлен текущим.  

Специальные средства повышения наглядности, называемые автопривязкой Auto-Snap, облегчают выбор точек при-
вязки и повышают эффективность использования объектной привязки. Средства автопривязки включают в себя следую-
щие элементы:  

– маркеры обозначают тип объектной привязки в точке привязки с помощью соответствующего символа;  
– всплывающие подсказки автопривязки поясняют тип объектной привязки в точке привязки ниже позиции указате-

ля мыши;  
– магнит автоматически перемещает в точку привязки указатель мыши, если он находится около возможной точки 

привязки;  
– прицел окружает перекрестье указателя мыши и ограничивает область рисунка, в пределах которой при перемеще-

нии указателя определяются возможные точки привязки. Показ прицела можно включать и отключать, а его размер – из-
менять. 

Для включения или отключения сразу всех текущих режимов объектной привязки без вызова диалогового окна 
Drafting Settings необходимо щелкнуть по кнопке OSNAP в строке состояния (или нажать клавиши Ctrl+F или F3). Если 
текущие режимы объектной привязки не заданы, вызывается диалоговое окно Drafting Settings. По умолчанию включены 
следующие элементы автопривязки: маркеры, всплывающие подсказки и магнит. Параметры автопривязки всегда можно 
изменить в поле Autosnap Settings на вкладке Drafting диалогового окна Options, которое вызывается щелчком мыши по 
кнопке Options... в диалоговом окне Drafting Settings либо из падающего меню Tools>Options. Если задано несколько ре-
жимов объектной привязки, AutoCAD использует режим, наиболее подходящий для выбранного объекта. Если в прицел 
выбора попадают две точки, удовлетворяющие заданному режиму, система производит привязку к той из них, которая 
лежит ближе к центру прицела. При необходимости можно переключаться между точками, нажимая клавишу Tab. На-
пример, если активизированы режимы привязки Quadrant и Center, а в прицел попадает часть окружности, то нажатие Tab 
позволит поочередно перебрать все возможные точки привязки: четыре квадранта и центр окружности. 

 

Объектное отслеживание расширяет и дополняет возможности объектной привязки. Для его использования необ-
ходимо, чтобы были включены режимы объектной привязки. При этом размер прицела определяет зону, в пределах кото-
рой происходит активизация линий отслеживания. При объектном отслеживании по умолчанию захват подходящих точек 
осуществляется автоматически. Однако можно установить такой режим, при котором захват точек происходит только при 
нажатии клавиши Shift. Автопривязка позволяет более простыми способами строить объекты, имеющие определенную гео-
метрическую зависимость от других объектов.  

 

Полярное отслеживание облегчает выбор точек, лежащих на воображаемых линиях, которые можно провести че-
рез последнюю указанную в команде точку под одним из заданных полярных углов. Если, например, шаг углов полярно-
го отслеживания равен 45°, линии отслеживания и всплывающие подсказки могут появляться под углами, кратными 45° 
относительно текущего направления отсчета углов. Текущая линия полярного отслеживания исчезает так же, как и 
всплывающая подсказка, если она оказывается вне прицела курсора. Полярное отслеживание может осуществляться под 
углами, кратными следующим стандартным значениям: 90; 45; 30; 22,5; 18; 15; 10 или 5°. Кроме того, пользователь мо-
жет определить другие значения углов. Для включения полярного отслеживания необходимо нажать функциональную 
клавишу F10 или кнопку POLAR в строке состояния. Линия полярного отслеживания и всплывающая подсказка появля-
ются, если прямая, мысленно проведенная через предыдущую указанную точку и курсор, проходит под углом, близким к 
одному из полярных углов отслеживания. По умолчанию шаг полярных углов равен 90°. Линию полярного отслеживания 
и информацию, содержащуюся во всплывающей подсказке, можно использовать при построении объектов.  

Для нахождения точки пересечения линии полярного отслеживания с другими объектами удобно задействовать ре-
жимы объектной привязки Intersection и Apparent Intersection. Режим ORTHO разрешает указание только тех точек, кото-
рые лежат на прямой, параллельной оси X или Y текущей ПСК и проходящей через последнюю указанную в текущей ко-
манде точку. При включении режима ортогонального рисования режим полярного отслеживания автоматически отклю-
чается, поскольку они не могут быть активными одновременно. Аналогичным образом при  отслеживании включения 
полярного отслеживания отключается режим ORTHO. Изменение параметров полярного отслеживания осуществляется 
на вкладке Polar Tracking диалогового окна Drafting Settings (рис. 10).  
 

 
 

Рис. 10. Диалоговое окно изменения параметров полярного отслеживания 



 

 
Это окно загружается из падающего меню Tools > Drafting Settings... или из контекстного меню, которое вызывается 

при щелчке правой кнопкой мыши по кнопке POLAR в строке состояния и последующем выборе пункта Settings.  
 

1.1.2. Построение линий 
 

Линия в AutoCAD является базовым примитивом. Линии бывают различного рода – одиночные отрезки, ломаные (с 
сопряжениями дугами или без них), пучки параллельных линий (мультилинии), а также эскизные. Линии рисуют, задавая 
координаты точек, свойства (тип, цвет и др.), значения углов.  

Отрезок. Команда LINE формирует отрезок и вызывается из падающего меню Draw>Line или щелчком мыши по 
пиктограмме Line на панели инструментов Draw. Отрезки могут быть одиночными или объединенными в ломаную ли-
нию. Несмотря на то, что сегменты соприкасаются в конечных точках, каждый из них представляет собой отдельный 
объект. Отрезки используются, если требуется работа с каждым сегментом в отдельности; если же необходимо, чтобы 
набор линейных сегментов представлял единый объект, лучше применять полилинии. Последовательность отрезков мо-
жет быть замкнутой – в этом случае конец последнего сегмента совпадает с началом первого. Запросы команды LINE: 
Specify first point: – указать первую точку; Specify next point or [Undo]: – указать следующую точку; Specify next point or 
[Undo]: Specify next point or [Close/Undo]: Specify next point or [Close/Undo]:.  

Запросы команды LINE организованы циклически. Это означает, что при построении непре-
рывной ломаной линии конец предыдущего отрезка служит началом следующего. При перемеще-
нии к каждой следующей точке за перекрестьем тянется "резиновая нить", что позволяет отслежи-
вать положение строящегося отрезка ломаной линии. При этом каждый отрезок ломаной линии 
представляет собой отдельный примитив. Цикл заканчивается после нажатия клавиши Enter в от-
вет на очередной запрос Specify next point or [Close/Undo]. К аналогичному результату приведет 
щелчок правой кнопкой мыши с последующим выбором пункта Enter из появившегося контекст-
ного меню (рис. 11).  

Ключи команды LINE: Close – замкнуть ломаную; Undo – отменить последний нарисованный 
отрезок. 

 

Прямая и луч. В AutoCAD 2005 допускается построение линий, не имеющих конца в одном 
или в обоих направлениях. Такие линии называются соответственно лучами и прямыми. Их можно 
использовать в качестве вспомогательных при построении других объектов. Наличие бесконечных линий не изменяет 
границ рисунка. Следовательно, бесконечные линии не влияют на процесс зумирования и на видовые экраны. Прямые и 
лучи разрешается перемещать, поворачивать и копировать таким же образом, как и любые другие объекты. Бесконечные 
линии обычно строятся на отдельном слое, который перед выводом на плоттер можно заморозить или отключить. Коман-
да XLINE, формирующая прямую, вызывается из падающего меню Draw>Construction Line или щелчком мыши по пикто-
грамме Construction Line на панели инструментов Draw. Прямые могут располагаться в любом месте трехмерного про-
странства. Существуют различные способы установки ориентации прямой. По умолчанию прямая строится путем указа-
ния двух точек, задающих ее ориентацию. Первая точка называется корневой – это условная середина прямой. Запросы 
команды XLINE: Specify a point or [Hor/Ver/Ang/Bisect/Offset]: Specify through point: Specify through point. Ключи коман-
ды XLINE: 

Ноr – построение горизонтальной прямой, проходящей через заданную точку;  
Ver – построение вертикальной прямой, проходящей через заданную точку;  
Ang – построение прямой по точке и углу.  
Есть два способа задать угол для построения прямых. Можно либо выбрать опорную линию и указать угол между 

нею и прямой, либо (для построения прямой, лежащей под определенным углом к горизонтальной оси) указать угол и 
точку, через которую должна проходить прямая. Построенные прямые всегда параллельны текущей ПСК;  

Bisect – по точке и половине угла, заданного тремя точками; при этом создается прямая, делящая какой-либо угол 
пополам. Нужно указать вершину угла и определяющие его линии;  

Offset – по смещению от базовой линии; при этом создается прямая, параллельная какой-либо базовой линии. Сле-
дует задать величину смещения, выбрать базовую линию, а затем указать, с какой стороны от базовой линии должна про-
ходить прямая.  

Команда RAY, формирующая луч, вызывается из падающего меню Draw>Ray или щелчком мыши по пиктограмме 
Ray на панели инструментов. Луч представляет собой линию в трехмерном пространстве, начинающуюся в заданной 
точке и уходящую в бесконечность. В отличие от прямых, бесконечных с обеих сторон, луч не имеет конца только в од-
ном направлении. Использование лучей вместо прямых помогает избежать загромождения рисунка. Как и прямые, лучи 
игнорируются командами, с помощью которых рисунок в его границах выводится на экран. Запросы команды RAY: 
Specify start point: – указать первую точку; Specify through point: – указать точку, через которую проходит луч.  

 

Полилиния. Команда PLINE, формирующая полилинию, вызывается из падающего меню Draw>Polyline или щелч-
ком мыши по пиктограмме Polyline на панели инструментов Draw. Полилиния представляет собой связанную последова-
тельность линейных и дуговых сегментов и обрабатывается системой как графический примитив. Полилинии использу-
ют, если требуется работа с набором сегментов как целым, хотя допускается их редактирование по отдельности. Можно 
задавать ширину или полуширину отдельных сегментов, сужать полилинию или замыкать ее. При построении дуговых 
сегментов первой точкой дуги является конечная точка предыдущего сегмента. Дуги описываются путем указания угла, 
центра, направления или радиуса. Кроме того, дугу можно построить, указав вторую и конечную точки. Запросы коман-
ды PLINE: Specify start point: – указать первую точку Current line-width is 0.0000 – текущая ширина полилинии равна 
0,0000. Specify next point or [Arc/Halfwidth/Length/Undo/ Width]: – указать следующую точку. Specify next point or 

Рис. 11.  
Контекстное  

меню 



 

[Arc/Close/Halfwidth/Length/Undo/Width]: – запросы команды PLINE организованы циклически. Цикл заканчивается по-
сле нажатия клавиши Enter в ответ на очередной запрос команды. К аналогичному результату приводит щелчок правой 
кнопкой мыши с последующим выбором пункта Enter в появившемся контекстном меню. Ключи команды PLINE (рис. 12 
и 13):  

Arc – обеспечивает переход в режим дуг;  
Close – замыкает полилинию отрезком. Замыкающий отрезок существенно отличается от обычного, проведенного от 

конечной точки к начальной. Они по-разному обрабатываются при редактировании и сглаживании полилиний, а также 
при подрезке углов стыков широких сегментов. Практически всегда предпочтительно использовать замыкающие отрезки;  

Half width – позволяет задать полуширину, т.е. расстояние от осевой линии широкого сегмента до края;  
Length – задает длину сегмента, созданного как продолжение предыдущего в том же направлении;  
Undo – отменяет последний созданный сегмент; 
Width – позволяет задать ширину последующего сегмента. AutoCAD запрашивает начальную и конечную ширину. 

 
 

Рис. 12. Построение полилинии с 
 установкой толщины 

 
Рис. 13. Построение полилинии в  

режиме дуг 
 
Введенное значение начальной ширины автоматически предлагается установить значением конечной ширины по 

умолчанию. Начальная и конечная точки широких линейных сегментов лежат на оси полилинии. Обычно угловые стыки 
смежных широких сегментов полилинии подрезаются; исключение составляют случаи, когда линейные сегменты не явля-
ются касательными к смежным дуговым сегментам, а также, если углы схождения очень острые или при использовании 
штрихпунктирных линий. При переходе команды PLINE в режим дуг запрос меняется следующим образом: 

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: запросы команды организованы циклически. 
ARC – переход в режим построения дуг Specify endpoint of arc or 

[Angle/Center/Close/Direction/Halfwidth/Line/Radius/Second pt/Undo/Width]: Ключи команды PLINE в режиме построения 
дуг:  

Angle – ввести центральный угол. По умолчанию дуга отрисовывается против часовой стрелки. Если требуется от-
рисовка дуги по часовой стрелке, необходимо задать отрицательное значение угла;  

CEnter – указать центр дуги;  
CLose – замкнуть дугой;  
Direction – задать направление касательной;  
Half width – определить полуширину полилинии;  
Line – перейти в режим построения отрезков;  
Radius – ввести радиус дуги;  
Second pt – указать вторую точку дуги по трем точкам. Если дуга не является первым сегментом полилинии, то она на-

чинается в конечной точке предыдущего сегмента и по умолчанию проводится по касательной к нему;  
Undo – отменить последнюю точку;  
Width – определить ширину полилинии.  
Заметим, что дуговые сегменты полилинии задаются любым из способов, характерных для команды формирования дуги 

ARC (см. соответствующий раздел данной главы). Кроме того, такие сегменты можно построить, задав радиус, центральный 
угол и направление хорды. Это единственный случай, когда дуга, предлагаемая по умолчанию, не строится по касательной. 

 

Мультилиния. Команда MLINE, формирующая мультилинию, вызывается из падающего меню Draw>Multiline или 
щелчком мыши по пиктограмме Multiline на панели инструментов. Мультилиния состоит из пучка параллельных линий, 
называемых ее элементами (рис. 14). Чтобы расставить элементы, необходимо указать смещение каждого из них относи-
тельно исходной точки. Можно создавать и сохранять стили мультилиний или же пользоваться стилем по умолчанию 
(мультилиния из двух элементов). Для каждого элемента задаются цвет и тип линии; соответствующие вершины элемен-
тов соединяются отрезками. Мультилинии могут иметь торцевые ограничители различного вида, например отрезки или 
дуги.  

Запросы команды MLINE: Current settings: Justification = Top, Scale = 20.00, Style = STANDARD – текущие настрой-
ки: расположение, масштаб, стиль; Specify start point or [Justification/Scale/STyle]: – указать начальную точку; Specify next 
point: – указать следующую точку; Specify next point or [Undo]: Specify next point or [Close/Undo]: Specify next point or 

[Close/Undo].  
Ключи команды MLINE: Justification – определение положения точки начала черчения: Тор 

– верх; Zero – центр; Bottom – низ. Линия проходит соответственно с максимальным положи-
тельным, с нулевым или максимальным отрицательным смещением от заданной точки;  

Рис. 14. Примеры  
мультилиний  



 

 
 

Рис. 15. Диалоговое окно 
создания стилей 
мультилинии 

 
 

 
 

Рис. 16. Диалоговое окно 
определения свойств элемента 

мультилинии 
 
 

Scale – коэффициент масштабирова-
ния. Смещение между линиями равняется 
заданному коэффициенту, умноженному на 
величину Offset, определенную в стиле;  

Style – выбор стиля. При построении 
мультилиний используется стиль мульти-
линии. Он создается в диалоговом окне 
Multiline Styles, которое вызывается из 
падающего меню Format>Multiline Style...
(рис. 15). Щелчком мыши по кнопке 
Load... можно загрузить существующий 
стиль; сохранить вновь созданный на дис-
ке – нажатием кнопки Save..., добавить 
свой – нажатием кнопки Add. Имя добав-
ляемого стиля должно быть задано в тек-
стовом поле Name:. По умолчанию ис-
пользуется стиль STANDARD.  

Свойства элементов мультилинии оп-
ределяются в диалоговом окне Element 
Properties (рис. 16):  

– в области Offset определяется сме-
щение линий мультилинии друг относи-
тельно друга;  

– нажатие кнопки Linetype... выводит 
на экран диалоговое окно определения 
типа линии;  

– нажатие кнопки Color... загружает 
диалоговое окно определения цвета каж-
дой линии.  

Свойства мультилинии определяются 
в диалоговом окне Multiline Properties 
(рис. 17):  

– в области Fill установкой флажка 
On обеспечивается заполнение мультили-
нии цветом;  

– в области формирования торцов Caps 
определяется вид концевых элементов;  

– в поле Angle определяется величина 
угла наклона концевого элемента к муль-
тилинии. По умолчанию используется 
файл стиля с именем acad.mln.  

Системная переменная CMLSTYLE 
содержит имя текущего стиля мультилинии. 

 
Рис. 17. Диалоговое окно 
определения свойств 

мультилинии 
Многоугольник. Команда POLYGON, обеспечивающая формирование правильного многоугольника, вызывается из 

падающего меню Draw > Polygon или щелчком мыши по пиктограмме Polygon на панели инструментов Draw.  
Многоугольники представляют собой замкнутые полилинии; они могут иметь от 3 до 1024 сторон равной длины. 

Многоугольник можно построить, либо вписав его в воображаемую окружность, либо описав вокруг нее, либо задав на-
чало и конец одной из его сторон. Так как длины сторон многоугольников всегда равны, с их помощью легко строить 
квадраты и равносторонние треугольники (рис. 18).  

Запросы команды POLYGON: Enter number of sides<default>: – указать число сторон; Specify center of polygon or 
[Edge]: – указать центр многоугольника. Ключи команды POLYGON: 

Edge – указание одной стороны. При использовании этого ключа команда POLYGON выдает следующие запросы:  
Specify first endpoint of edge: –  указать первую конечную точку стороны; 
Specify second endpoint of edge: – указать вторую конечную точку стороны. При указании центра многоугольника 

команда POLYGON выдает следующие запросы: Enter an option [Inscribed in circle/Circumscribed about circle]<I>: – задать 
опцию размещения Specify radius of circle: – задать радиус окружности, где:  

Inscribed in circle – формирование многоугольника, вписанного в окружность;  
Circumscribed about circle – формирование многоугольника, описанного вокруг окружности.  
Вписанные многоугольники строятся (рис. 19), когда известно расстояние между центром многоугольника и его 

вершинами. Описанные многоугольники – когда известно расстояние между центром многоугольника и серединами его 
сторон (рис. 20). 



 

 
 
 
 
 
 
 
 

 
 

 
 

 
1.1.3. Построение криволинейных объектов 

 

Сплайн. Команда SPLINE – формирующая сплайн, вызывается из падающего меню Draw > Spline или щелчком мы-
ши по пиктограмме Spline на панели инструментов Draw. Сплайн представляет собой гладкую кривую, проходящую че-
рез заданный набор точек. AutoCAD работает с одной из разновидностей сплайнов – неоднородными рациональными  
В-сплайновыми кривыми NURBS. Использование NURBS обеспечивает достаточную гладкость кривых, проходящих 
через заданные контрольные точки. Сплайны применяются для рисования кривых произвольной формы, например гори-
зонталей в географических информационных системах или при проектировании автомобилей.  

Сплайн можно строить путем интерполяции по набору точек, через которые он должен проходить. Таким способом 
при построении кривых для двумерного и трехмерного моделирования достигается на много большая точность, чем при 
использовании полилиний. К тому же рисунок, использующий сплайны, занимает меньше места на диске и в оператив-
ной памяти, чем рисунок с полилиниями.  

Запросы команды SPLINE: Specify first point or [Object]: – указать первую точку; Specify next point: – указать сле-
дующую точку; Specify next point or [Close/Fit tolerance]<start tangent>: Specify next point or [Close/Fit tolerance]<start tan-
gent>:. Сплайн строится путем указания координат определяющих точек.  

Сплайны могут быть замкнутыми; при этом совпадают как сами конечная и начальная точки, так и направления ка-
сательных в них. Кроме того, в ходе построения можно изменять допуск сплайновой аппроксимации – величину, опреде-
ляющую, насколько близко проходит сплайн к указанным определяющим точкам. Чем меньше значение допуска, тем 
ближе сплайн к определяющим точкам; при нулевом допуске он проходит прямо через них.  

 

Окружность. Команда CIRCLE, формирующая окружность, вызывается из падающего меню 
Draw>Circle или щелчком мыши по пиктограмме Circle на панели инструментов Draw. Окружности 
можно строить различными способами (рис. 21).  

По умолчанию построение производится путем указания центра и радиуса. Можно задавать 
центр и диаметр или только диаметр, указывая его начальную и конечную точки (рис. 22). Окруж-
ность также может строиться по трем точкам (рис. 23). Кроме того, имеется возможность опреде-
лять окружность, касающуюся либо трех объектов рисунка, либо двух (в последнем случае задает-
ся еще и радиус), (рис. 24).  

 

 
 

Запросы команды CIRCLE: Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: – указать центр окружности; 
Specify radius of circle or [Diameter]: – указать радиус окружности.  

Ключи команды CIRCLE:  
3Р – строит окружность по трем точкам, лежащим на окружности. При использовании этого ключа команда CIRCLE вы-

дает следующие запросы: 
 
 

 

 
 
 
 

 
 

Specify center point for circle or [3P/2P/Ttr (tan 
tan radius)]:  

3P – переход в режим построения окружно-
сти по трем точкам; Specify first point on circle: – 
указать первую точку окружности; Specify second 
point on circle: – указать вторую точку окружно-
сти Specify third point on circle: – указать третью 
точку окружности; 

2Р – строит окружность по двум точкам, лежа-
щим на диаметре. При использовании этого ключа 
команда CIRCLE выдает следующие запросы:  

Specify center point for circle or [3P/2P/Ttr (tan 
tan radius)]: 2P – переход в режим построения ок-
ружности по двум точкам;  

Specify first end point of circle's diameter:– 

Рис. 21. Построение  
окружности по  
центру и радиусу 

Рис. 18. Построение  
многоугольника по  
известной стороне 

Рис. 20. Построение  
описанного  

многоугольника 

Рис. 19. Построение 
вписанного  

многоугольника 

Рис. 22. Построение  
окружности по двум  
точкам диаметра 



 

 

 
 
 

 

 

указать первую конечную точку диаметра окруж-
ности; 

Specify second end point of circle's diameter: – 
указать вторую конечную точку диаметра окруж-
ности;  

Ttr – строит окружность по двум касатель-
ным и радиусу. При использовании этого ключа 
команда CIRCLE выдает следующие запросы:  

Specify center point for circle or [3P/2P/Ttr (tan 
tan radius]:  

TTR – переход в режим построения окруж-
ности по двум касательным и радиусу; Specify 
point on object for first tangent of circle: – указать 
точку на объекте, задающую первую 
касательную; Specify point on object for second 
tangent of circle: – указать точку на объекте, за-
дающую вторую касательную; Specify radius of 
circle <default>: – указать радиус окружности.  

 

 
 

  
 

Дуга. Команда ARC, формирующая дугу» вызывается из падающего меню Draw>Arc или щелчком мыши по пикто-
грамме Arc на панели инструментов Draw. Дуги можно строить различными способами. По умолчанию построение про-
изводится путем указания трех точек: начальной, промежуточной и конечной. Дугу можно также определить, задав цен-
тральный угол, радиус, направление или длину хорды. Хордой называется отрезок, соединяющий начало и конец дуги. 
По умолчанию дуга рисуется против часовой стрелки. Ключи команды ARC:  

Center – точка центра дуги;  
End – конечная точка дуги;  
Angle – величина угла;  
chord Length – длина хорды;  
Direction – направление касательной;  
Radius – радиус дуги.  
Существует несколько способов построения дуги при помощи команды ARC:  
SPoint – построение дуги по трем точкам, лежащим на дуге (рис. 29). Запросы команды ARC:  

Рис. 24. Построение  
окружности,  
касательной 

двум примитивам 

Рис. 23. Построение  
окружности по трем  

точкам 

Рис. 25. Построение 
 окружности, касательной двум 

другим окружностям 

Рис. 26. Построение 
окружности, касательной  

прямой 

Рис. 27. Построение окружности по 
двум точкам диаметра, лежащим на 

концах отрезка 

Рис. 28. Построение 
концентрической 

окружности 



 

Specify start point of arc or [CEnter]: – указать начальную точку дуги; Specify second point of arc or [CEnter/ENd]: – 
указать вторую точку дуги; Specify end point of arc: – указать конечную точку дуги;  

Start, Center, End – построение дуги по стартовой точке, центру и конечной точке дуги. Положительным направлени-
ем считается построение дуги против часовой стрелки. Запросы:  

Specify start point of arc or [CEnter]: – указать начальную точку дуги; Specify second point of arc or [CEnter/ENd]: С – 
переход в режим построения дуги по центру; Specify center point of arc: – указать центр дуги; Specify end point of arc or 
[Angle/chord Length]: – указать конечную точку дуги;  

Start, Center, Angle – построение дуги по стартовой точке, центру и углу (рис. 30). Положительным направлением 
считается построение дуги против часовой стрелки; изменить направление на противоположное можно, задав отрица-
тельное значение угла. Запросы:  

Specify start point of arc or [CEnter]: – указать начальную точку дуги; Specify second point of arc or [CEnter/ENd]: С – 
переход в режим построения дуги по центру; Specify center point of arc: – указать центр дуги; Specify end point of arc or 
[Angle/chord Length]: A – переход в режим построения дуги по углу; Specify included angle: – указать центральный угол;  

Start, Center, Length – построение дуги по стартовой точке, центру и длине хорды. Дуга строится против часовой 
стрелки от начальной точки, причем по умолчанию – меньшая из двух возможных (т.е. дуга, которая меньше 180°). Если 
же вводится отрицательное значение длины хорды, будет нарисована большая дуга. Запросы:  

Specify start point of arc or [CEnter]: – указать начальную точку дуги; Specify second point of arc or [CEnter/ENd]: С – 
переход в режим построения дуги по центру; Specify center point of arc: – указать центр дуги; Specify end point of arc or 
[Angle/chord Length]: L – переход в режим построения дуги по длине хорды; Specify length of chord: – указать длину хор-
ды;  

Start, End, Angle – построение дуги по стартовой точке, конечной точке и углу. Положительным направлением счи-
тается построение дуги против часовой стрелки, изменить направление на противоположное можно, задав отрицательное 
значение угла. Запросы:  

Specify start point of arc or [CEnter]: – указать начальную точку дуги; Specify second point of arc or [CEnter/ENd]: E – 
переход в режим построения дуги по конечной точке; Specify end point of arc: – указать конечную точку дуги; Specify 
center point of arc or [Angle/Direction/Radius]: A – переход в режим построения дуги по углу; Specify included: – указать 
центральный угол; 

Start, End, Direction – построение дуги по стартовой точке, конечной точке и направлению – углу наклона касатель-
ной из начальной точки. Запросы:  

 

 
 

Рис. 29. Построение 
дуги по  

трем точкам 

 
 
 

Рис. 30. Построение 
дуги по стартовой 
точке, центру и углу

 
Рис. 31. Построение 
дуги по стартовой  

точке, центру и радиусу 
 

 
Specify start point of arc or [CEnter]: – указать начальную точку дуги; Specify second point of arc or [CEnter/ENd]: E – 

переход в режим построения дуги по конечной точке; Specify end point of arc: – указать конечную точку дуги; > Specify 
center point of arc or [Angle /Direction /Radius]: D – переход в режим построения дуги по направлению касательной; Specify 
tangent direction for the start point of arc: – указать направление касательной от начальной точки дуги; 

Start, End, Radius – построение дуги по стартовой точке, конечной точке и радиусу (рис. 31). Строится меньшая дуга 
против часовой стрелки. Запросы:  

Specify start point of arc or [CEnter] – указать начальную точку дуги; Specify secojid point of arc or [CEnter/ENd]: E – 
переход в режим построения дуги по конечной точке; Specify end point of arc: – указать конечную точку дуги; Specify 
center point of arc or [Angle/Direction/Radius]: R – переход в режим построения дуги по радиусу; Specify radius of arc: – 
указать радиус дуги;  

Center, Start, End – построение дуги по центру, стартовой и конечной точке. Запросы:  
Specify start point of arc or [CEnter]: С – переход в режим построения дуги по центру;  
Specify center point of arc: – указать центр дуги;  
Specify start point of arc: – указать начальную точку дуги; Specify end point of arc or [Angle/chord Length]: – указать 

конечную точку дуги; 
Center, Start, Angle – построение дуги по центру, стартовой точке и углу. Запросы:  
Specify start point of arc or [CEnter] – переход в режим построения дуги по центру; 
Specify center point of arc: – указать центр дуги;  
Specify start point of arc: – указать начальную точку дуги;  
Specify end point of arc or [Angle/chord Length]: А – переход в режим построения дуги по углу; 
Specify included angle: – указать центральный угол; 
Center, Start, Length – построение дуги по центру, стартовой точке и длине хорды. Запросы:  
Specify start point of arc or [CEnter]: С – переход в режим построения дуги по центру;  
Specify center point of arc: – указать центр дуги;  
Specify start point of arc: – указать начальную точку дуги;  



 

Specify end point of arc or [Angle/chord Length]: L – переход в режим построения дуги по длине хорды;  
Specify length of chord: – указать длину хорды;  
ArcCont: – построение дуги как продолжения предшествующей линии или дуги. При этом начальной точкой дуги и 

ее начальным направлением станут соответственно конечная точка и конечное направление последней созданной дуги 
или последнего созданного отрезка. Такой способ особенно удобен для построения дуги, касательной к заданному отрезку. 
Запросы:  

Specify start point of arc or [Cеnter]: – указать начальную точку дуги; Specify end point of arc: – указать конечную точ-
ку дуги.  

 

Эллипс. Команда ELLIPSE, обеспечивающая формирование эллипса, вызывается из падающего меню Draw>Ellipse 
или щелчком мыши по пиктограмме Ellipse на панели инструментов Draw. Имеется возможность строить эллипсы и эл-
липтические дуги, причем с математической точки зрения эти объекты – действительно эллипсы, а не какие-либо аппрок-
симирующие их кривые (рис. 32). По умолчанию построение эллипсов производится путем указания начальной и конеч-
ной точек первой оси, а также половины длины второй оси. Самая длинная ось эллипса называется его большой осью, 
самая короткая – малой. Оси могут определяться в любом порядке. Запросы команды ELLIPSE: Specify axis endpoint of 
ellipse or [Arc/Center]: – указать конечную точку оси эллипса; Specify other endpoint of axis: – указать вторую конечную 
точку оси; Specify distance to other axis or [Rotation]: – указать длину другой оси. Ключи команды ELLIPSE: Center – ука-
зание центра эллипса. Запросы:  

Specify axis endpoint of ellipse or [Arc/Center]: С – переход в режим указания центра эллипса; 
Specify center of ellipse: – указать центр эллипса; Specify endpoint of axis: – указать конечную 
точку оси; Specify distance to other axis or [Rotation]: – указать длину другой оси;  

Arc – режим построения эллиптических дуг. По умолчанию эллиптические дуги, как и эл-
липсы, строятся путем указания конечных точек первой оси и половины длины второй. После 
этого задаются начальный и конечный углы.  

Нулевым углом считается направление от центра эллипса вдоль его большой оси. Направ-
ление возрастания угла определяется значением системной переменной ANGDIR. Если она рав-
на 0, то возрастание угла происходит при движении против часовой стрелки; если 1 – по часовой 
стрелке. Если начальный и конечный углы совпадают, строится полный эллипс. Вместо конеч-

ного угла можно указать центральный угол дуги, измеренный от начальной точки. Запросы:  
Specify axis endpoint of ellipse or [Arc/Center]: А – переход в режим построения эллиптических дуг; Specify axis 

endpoint of elliptical arc or [Center]: – указать конечную точку оси эллиптической дуги; Specify other endpoint of axis: – ука-
зать вторую конечную точку оси; Specify distance to other axis or [Rotation]: – указать длину другой оси; Specify start angle 
or [Parameter]: – указать начальный угол; Specify end angle or [Parameter/Included angle]: – указать конечный угол. 

 

Кольцо. Команда DONUT формирует кольца и вызывается из падающего меню Draw>Donut или щелчком мыши по 
пиктограмме Donut. С помощью функции построения колец легко строить закрашенные кольцеобразные объекты и круги 
(рис. 33).  

В действительности они представляют собой замкнутые полилинии ненулевой ши-
рины.  

Для построения кольца необходимо задать его внутренний и внешний диаметры, а 
также центр.  

За один вызов команды можно построить любое количество колец одинакового 
диаметра, но с разными центрами. Работа команды завершается нажатием клавиши 
Enter. Если требуется построить заполненный круг, следует задать нулевой внутренний 
диаметр кольца.  

Текущее значение внутреннего диаметра кольца хранится в системной переменной DONUT ID, а значение внешнего 
диаметра – в переменной DONUTOD.  

Закраской колец и широких полилиний управляет системная переменная FILLMODE. Запросы команды DONUT: 
Specify inside diameter of donut <default>: – указать внутренний диаметр кольца; Specify outside diameter of donut <default>: 
– указать внешний диаметр кольца; Specify center of donut or <exit>: – указать центр кольца; Specify center of donut or 
<exit>: – указать центр кольца; Specify center of donut or <exit>: – для завершения команды нажать клавишу Enter. 
 

1.2. КОМАНДЫ ОФОРМЛЕНИЯ ЧЕРТЕЖЕЙ 
 

1.2.1. Штриховка 
 

Штрихование – это заполнение указанной области по определенному образцу. Команда ВНАТСН, формирующая ас-
социативную штриховку, вызывается из падающего меню Draw>Hatch... или щелчком мыши по пиктограмме Hatch на 
панели инструментов Draw. При обращении к команде ВНАТСН загружается диалоговое окно Boundary Hatch and Fill, 
показанное на рис. 34 [4].  
 

Рис. 33. Построение кольца 

Рис. 32. Построение 
эллипса 



 

 
 

Рис. 34. Диалоговое окно штриховки 
 

Команда ВНАТСН позволяет наносить не только ассоциативную, но и неассоциативную штриховку. Ассоциатив-
ность здесь означает, что при изменении границ контура изменяется и штриховка. Неассоциативная штриховка не зави-
сит от контура границы. Определение контура в команде ВНАТСН производится автоматически на основании указания 
точки, принадлежащей штрихуемой области. Все объекты, полностью или частично попадающие в область штриховки и 
не являющиеся ее контуром, игнорируются и не влияют на процесс штриховки. В некоторых случаях контур содержит 
выступающие края и островки, которые можно либо штриховать, либо пропускать. Островками называются замкнутые 
области, расположенные внутри области штрихования. Команда ВНАТСН позволяет штриховать область, ограниченную 
замкнутой кривой, как путем простого указания внутри контура, так и путем выбора объектов. При этом контур опреде-
ляется автоматически, а любые целые примитивы и их составляющие, которые не являются частью контура, игнорируют-
ся. В поставку AutoCAD входит более 50 образцов штриховки, удовлетворяющих промышленным стандартам и служа-
щих для обозначения различных компонентов объектов или графического представления различных материалов. В про-
грамме имеется 14 образцов штриховки, удовлетворяющих стандартам ISO (Международной организации по стандарти-
зации). Для штриховки по стандарту ISO можно задать ширину пера, которая определяет вес линии образца. Помимо об-
разцов, поставляемых с AutoCAD, можно использовать образцы из внешних библиотек. Выбор образца штриховки осу-
ществляется в области Pattern:. Удобно пользоваться как раскрывающимся списком, так и диалоговым окном Hatch 
Pattern Palette, показанным на рис. 35, где содержатся пиктограммы с графическими образцами различных штриховок. 
Для выбора образца штриховки достаточно указать его изображение.  

Для использования стандартных образцов штриховок необходимо в области Туре: выбрать из раскрывающегося 
списка пункт Predefined. Имя образца штриховки запоминается в системной переменной HPNAME. Текстовые поля Scale: 
и Angle: позволяют задать масштабный коэффициент и угол наклона для выбранного образца штриховки. При этом вве-
денные параметры запоминаются в системных переменных HPSCALE и HPANG. 

 
 

Рис. 35. Диалоговое окно с образцами штриховки 
Чтобы создать новый пользовательский образец штриховки, надо в области Туре: выбрать из раскрывающегося спи-

ска пункт User defined. При этом следует задать угол наклона в поле Angle:, расстояние между линиями штриховки в поле 



 

Spacing: и, если необходимо, поставить флажок Double для отрисовки дополнительных линий под углом 90° к основным 
линиям штриховки.  

Ассоциативность штриховки устанавливается в области Composition выбором одного из параметров: Associative или 
Noassociative. Для автоматического определения контура штриховки путем указания точек необходимо нажать кнопку 
Pick Points. При этом выдается запрос: Select internal point: – указать внутреннюю точку; Selecting everything – осуществ-
ляется выбор всех объектов; Selecting everything visible – осуществляется выбор всех видимых объектов; Analyzing the 
selected data – осуществляется анализ выбранных данных; Analyzing internal islands – осуществляется анализ внутренних 
островков; Select internal point: – указать внутреннюю точку; Analyzing internal islands – осуществляется анализ внутрен-
них островков; Select internal point: – нажать клавишу Enter по завершении выбора штрихуемой области. При определе-
нии нескольких контуров штриховки необходимо выбрать несколько внутренних точек, а затем нажать клавишу Enter. 
Если AutoCAD определяет, что контур не замкнут или точка находится не внутри контура, то на экране появляется диа-
логовое окно Boundary Definition Error с сообщением об ошибке. Для выбора любым стандартным способом объектов в 
качестве контура штриховки необходимо нажать кнопку Select objects. Контуры штриховки могут представлять собой 
любую комбинацию отрезков, дуг, окружностей, двумерных полилиний, эллипсов, сплайнов, блоков и видовых экранов 
пространства листа. Каждый из компонентов контура должен хотя бы частично находиться в текущем виде. По умолча-
нию AutoCAD определяет контуры путем анализа всех замкнутых объектов рисунка. Когда штрихование производится 
стилем Normal, островки остаются незаштрихованными, а вложенные островки штрихуются, как показано на рис. 36. При 
этом штрихование производится вовнутрь, начиная от внешнего контура.  
 

 
Если обнаружено внутреннее пересечение, штрихование прекращается, а на следующем пересечении возобновляет-

ся. Таким образом, данный стиль задает штрихование областей, отделенных от внешней части нечетным числом замкну-
тых контуров; области, отделенные четным числом контуров, не штрихуются. При использовании игнорирующего Ignore 
и внешнего стиля Outer штриховка аналогичного контура выглядит иначе, (рис. 37, 38). Стиль Ignore задает штрихование 
всей области, ограниченной внешним контуром, без учета вложенных контуров. 

При использовании стиля Outer штрихование производится от внешнего контура и окончательно прекращается при 
первом обнаруженном пересечении. Стили Normal, Ignore и Outer устанавливаются в области Island detection style на 
вкладке Advanced диалогового окна Boundary Hatch (рис. 39).  

 
 

Рис. 39. Диалоговое окно определения стилей штриховки 
 
Если на пути линии штриховки встречаются текст, атрибут, форма, полоса или закрашенная фигура и данный объект 

входит в набор контуров, AutoCAD не наносит на него штриховку. В результате, например, читаемость текста, разме-
щенного внутри заштрихованного контура, не ухудшается. Если же перечисленные объекты также нужно заштриховы-
вать, следует воспользоваться стилем Ignore.  

Рис. 36. Пример контура, 
заштрихованного стилем 

Normal 

Рис. 37. Пример контура, 
заштрихованного стилем 

Ignore 

Рис. 38. Пример контура, 
заштрихованного стилем 

Outer 



 

Выбор образца штриховки можно осуществить в окне инструментальной палитры, перетащив образец штриховки на 
заданный контур. 

1.2.2. Простановка размеров 
 

Размеры показывают геометрические величины объектов, расстояния и углы между ними, координаты отдельных 
точек. В AutoCAD используется 11 видов размеров, которые можно разделить на три основных типа: линейные (рис. 40 – 
42), радиальные (рис. 43) и угловые (рис. 44).  

 

 
Рис. 40. Горизонтальный, 

вертикальный и 
параллельный размеры 

 
 
 

 

Рис. 41. Базовые  
размеры 

 

 
 
 

 
 

Рис. 42. Размерные 
цепи 

 
 

 
Рис. 43. Радиальные размеры 

 
Рис. 44. Угловые размеры 

 
Линейные размеры делятся на горизонтальные, вертикальные и параллельные, повернутые, ординатные, базовые и 

размерные цепи.  
Команды простановки размеров находятся в падающем меню Dimension. Для удобства можно воспользоваться пик-

тограммами на одноименной панели инструментов (рис. 45). 
В изображения размеров входят следующие составные элементы:  
• размерная линия – линия со стрелками на концах, выполненная параллельно соответствующему измерению. Как 

правило, размерные линии помещаются между выносными. Если на короткой размерной линии не хватает места, размер-
ные стрелки или текст размещаются снаружи в зависимости от настроек размерного стиля. Для угловых размеров раз-
мерной линией является дуга; 
 

 
 
 

Рис. 45. Падающее меню и панель инструментов Dimension 
 

• размерные стрелки – стрелки, засечки или произвольный маркер, определяемый как блок, для обозначения кон-
цов размерной линии;  



 

• выносные линии проводятся от объекта к размерной линии. Могут быть построены перпендикулярно ей или 
быть наклонными. Формируются только для линейных и угловых размеров (используются, если размерная линия нахо-
дится вне образмериваемого объекта);  

• размерный текст – текстовая строка, содержащая величину размера и другую информацию (например, обозначе-
ния диаметра, радиуса, допуска). Это необязательный элемент, т.е. его вывод на рисунок можно подавить. Есть возмож-
ность принять размер, автоматически вычисленный AutoCAD, или заменить его другим текстом. Если принимается текст 
по умолчанию, к нему можно автоматически добавить допуски и ввести префикс и суффикс;  

• выноски используются, если размерный текст невозможно расположить рядом с объектом;  
• маркер центра – небольшой крестик, отмечающий центр окружности или дуги;  
• осевые линии – линии с разрывом (штрихпунктирные), пересекающиеся в центре окружности или дуги и деля-

щие ее на квадранты.  
Все линии, стрелки, дуги и элементы текста, составляющие размер, будут рассматриваться как один размерный 

примитив, если установлен режим ассоциативного образмеривания. Ассоциативные размеры изменяются в соответствии 
с изменением элементов, которые образмериваются.  

Линейные размеры. AutoCAD обеспечивает несколько видов простановки линейных размеров, отличающихся уг-
лом, под которым проводится размерная линия. Команда DIMLINEAR позволяет создавать горизонтальный, вертикаль-
ный, повернутый или параллельный размеры (рис. 46 – 49). 

 
Рис. 46. Простановка  

горизонтального размера 

 

 
Рис. 47. Простановка  
вертикального размера 

 
Рис. 48. Простановка 
повернутого размера

 

 
Рис. 49. Простановка  
параллельного размера 

 
Команда вызывается из падающего меню Dimension>Linear или щелчком мыши по пиктограмме Linear Dimension на 

панели инструментов Dimension. Запросы команды DIMLINEAR: Specify first extension line origin or <select object>: – ука-
зать начало первой выносной линии; Specify second extension line origin: – указать начало второй выносной линии; Specify 
dimension line location or [Mtext/Text/Angle/Horizontal/Vertical/Rotated]: – указать положение размерной линии Dimension 
text = измеренное значение. Если на первый запрос нажать клавишу Enter, команда DIMLINEAR выдает следующие за-
просы: Specify first extension line origin or <select object>: – нажать клавишу Enter для указания объекта; Select object to 
dimension: – выбрать объект для нанесения размера; Specify dimension line location or 
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: – указать положение размерной линии Dimension text = измеренное значе-
ние. Ключи команды DIMLINEAR: Mtext – позволяет редактировать размерный текст в редакторе многострочного текста, 
можно полностью изменить текст или сохранить измеренное значение с помощью угловых скобок  и при необходимости 
добавить любой текст до и после скобок; Text – позволяет редактировать размерный текст, при этом выдается запрос: 
Enter dimension text <измеренное значение>: – ввести необходимую текстовую строку; Angle – позволяет задать угол по-
ворота размерного текста, при этом выдается запрос: Specify angle of dimension text: – указать угол поворота размерного 
текста; Horizontal – определяет горизонтальную ориентацию размера, отмеряет расстояние между двумя точками по оси 
X; Vertical – определяет вертикальную ориентацию размера, отмеряет расстояние между двумя точками по оси Y; Rotated 
– осуществляет поворот размерной и выносных линий, отмеряет расстояние между двумя точками вдоль заданного на-
правления в текущей ПСК. При этом выдается запрос: Specify angle of dimension line <0>: – указать угол поворота раз-
мерной линии. 

 

Параллельный размер. С помощью команды DIMALIGNED создается размер, параллельный измеряемой линии 
объекта. Размер создается подобно горизонтальному, вертикальному и повернутому. Команда вызывается из ниспадаю-
щего меню Dimension>Aligned или щелчком мыши по пиктограмме Aligned Dimension на панели инструментов 
Dimension. Запросы команды DIMALIGNED: Specify first extension line origin or <select object>: – указать начало первой 
выносной линии; Specify second extension line origin: – указать начало второй выносной линии; Specify dimension line 
location or [Mtext/Text/Angle]: – указать положение размерной линии Dimension text = измеренное значение. 
 
 
 
 
 



 

 
 
Базовые размеры и размерные цепи представляют собой последовательность линейных 

размеров. Базовые размеры – это последовательность размеров, отсчитываемых от одной 
базовой линии (рис. 50). У размерных цепей начало каждого размера совпадает с концом 
предыдущего. Перед построением базового размера или цепи на объекте должен быть про-
ставлен хотя бы один линейный, ординатный или угловой размер. Команда DIMBASELINE 
позволяет создавать базовые размеры. Вызывается она из падающего меню 
Dimension>Baseline или щелчком мыши по пиктограмме Baseline Dimension на панели ин-
струментов Dimension. Запросы команды DIMBASELINE: Specify a second extension line 
origin or [Undo/Select] <Select>: – указать начало второй выносной линии Dimension text = 
измеренное значение; Specify a second extension line origin or [Undo/Select] <Select>: – ука-
зать начало следующей выносной линии Dimension text = измеренное значение; Specify a 
second extension line origin or [Undo/Select] <Select>: – указать начало следующей выносной линии Dimension text = изме-
ренное значение; Specify a second extension line origin or [Undo/Select] <Select>: – указать начало следующей выносной 
линии или нажать клавишу Enter; Select base dimension: – выбрать исходный размер или нажать клавишу Enter для завер-
шения команды. Если предыдущий размер не был линейным или если в ответ на первый запрос была нажата клавиша 
Enter, то предлагается выбрать линейный размер, который будет использоваться в качестве базового. При этом выдается 
следующий запрос: Select base dimension: – выбрать исходный размер. Далее следуют стандартные запросы команды 
DIMBASELINE. Расстояние между размерными линиями в базовых размерах задается системной переменной DIMDLI. 

 

Размерная цепь. Команда DIMCONTINUE позволяет создавать последовательную размерную цепь (рис. 51). Ко-
манда вызывается из падающего меню Dimension>Continue или щелчком мыши по пиктограмме Continue Dimension на 
панели инструментов Dimension. Запросы команды DIMCONTINUE: Specify a second extension line origin or [Undo/Select] 

<Select>: – указать начало второй выносной линии Dimension text = измеренное значение; 
Specify a second extension line origin or [Undo/Select] <Select>: – указать начало следующей вы-
носной линии Dimension text = измеренное значение; Specify a second extension line origin or 
[Undo/Select] <Select>: – указать начало следующей выносной линии Dimension text = из-
меренное значение; Specify a second extension line origin or [Undo/Select] <Select>: – ука-
зать начало следующей выносной линии или нажать клавишу Enter; Select continued 
dimension: – выбрать исходный размер или нажать клавишу Enter для завершения коман-
ды. Если предыдущий размер не был линейным или если в ответ на первый запрос была 
нажата клавиша Enter, то предлагается выбрать линейный размер, который будет исполь-
зован для продолжения. При этом выдается следующий запрос: Select continued dimension: 

– выбрать исходный размер. Далее следуют стандартные запросы команды DIMCONTINUE.  
 

Радиальные размеры. Команда DIMDIAMETER строит диаметр окружности или дуги (рис. 52). Команда вызывается из 
падающего меню Dimension>Diameter или щелчком мыши по пиктограмме Diameter Dimension на панели инструментов 
Dimension. Запросы команды DIMDIAMETER: Select arc or circle: – выбрать дугу или круг Dimension text = измеренное 
значение; Specify dimension line location or [Mtext/Text/Angle]: – указать положение размерной линии. При простановке 
размера диаметра текст по умолчанию начинается со знака 0. Ключи команды позволяют изменять размерный текст и 
угол наклона размерного текста. Маркеры центра и осевые линии автоматически появляются в центре дуги или круга, 
если размер проставляется снаружи, и не наносятся, если размер проставляется внутри круга или дуги, а также в случае, 
когда маркеры центра отключены. Имеется возможность произвести принудительное размещение размерного текста и линии-
выноски внутри круга или дуги. 

Команда DIMRADIUS, позволяющая построить радиус окружности или дуги (рис. 53), вызывается из падающего 
меню Dimension>Radius или щелчком мыши по пиктограмме Radius Dimension на панели инструментов Dimension. За-
просы DIMRADIUS аналогичны запросам команды DIMDIAMETER. По умолчанию при простановке радиуса текст на-
чинается с символа R.  

 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 

Рис. 50. Простановка  
базовых размеров 

Рис. 51. Постановка 
последовательной 
размерной цепи 

Рис. 52. Простановка  
диаметра 

Рис. 53. Простановка  
радиуса 



 

 
 
 

Угловые размеры. Команда DIMANGULAR позволяет проставить угловой размер 
(рис. 54). Она вызывается из падающего меню Dimension> Angular или щелчком мыши по 
пиктограмме Angular Dimension на панели инструментов Dimension. Запросы команды 
DIMANGULAR: Select arc, circle, line, or <specifу vertex>: – выбрать дугу, круг, отрезок; 
Select second line: – если первое указание было отрезком, следует указать второй отрезок, 
не параллельный первому; Specify dimension arc line location or [Mtext/Text/Angle]: – ука-
зать местоположение размерной линии Dimension text = измеренное значение. Если в ответ 
на первый запрос нажата клавиша Enter, то угловой размер строится по трем точкам и ко-
манда DIMANGULAR выдает следующие запросы: Specify angle vertex: – выбрать верши-
ну угла; Specify first angle endpoint: – указать первую конечную точку угла; Specify second 
angle endpoint: – указать вторую конечную точку угла; Specify dimension arc line location or 

[Mtext/Text/Angle]: – указать местоположение размерной линии Dimension text = измеренное значение. При простановке 
углового размера текст по умолчанию завершается знаком градуса °.  

Ключи команды позволяют изменять размерный текст и угол его наклона. Когда угол образован двумя непараллель-
ными прямыми, размерная дуга стягивает угол между ними. Если в этом случае дуга не пересекается с обоими или с од-
ним из образмериваемых отрезков, AutoCAD проводит одну или две выносные линии до пересечения с размерной дугой. 
Стягиваемый угол всегда меньше 180°.  

 

Ординатные размеры определяют расстояние по оси координат от базовой точки до образмериваемого объекта 
(например, до отверстия в детали). Применение таких размеров предохраняет от накапливающихся ошибок, поскольку 
положение объектов отмеряется от единой базовой точки. Ординатный размер состоит из значения координаты х или у и 
выноски. Ординатный размер по X выражает расстояние от начала координат до объекта вдоль оси X, а ординатный раз-
мер по У – соответственно вдоль оси Y. Если указана точка, AutoCAD автоматически определяет, по какой оси простав-
лять ординатный размер. Такой способ называется автоматическим нанесением ординатных размеров.  

Текст ординатного размера располагается вдоль выноски независимо от ориентации текста, заданной текущим раз-
мерным стилем. Ключи команды позволяют изменять размерный текст и угол его наклона. Выноска-отрезок или каждый 
сегмент выноски-ломаной отрисовывается перпендикулярно одной из осей координат, поэтому целесообразно включать 
режим ORTHO. Команда DIMORDINATE позволяет проставлять ординатные размеры. Она вызывается из падающего 
меню Dimension>Ordinate или щелчком мыши по пиктограмме Ordinate Dimension на панели инструментов Dimension. 
Запросы команды DIMORDINATE: Specify feature location: – указать положение элемента; Specify leader endpoint or 
[Xdatum/Ydatum/Mtext/Text/Angle]: –  указать конечную точку выноски или координату, которую необходимо изменить; 
как следствие, изменится ориентация выносок и размерного текста Dimension text = измеренное значение.  

Команда QLEADER, предназначенная для построения выноски, вызывается из падающего меню Dimension>Leader 
или щелчком мыши по пиктограмме Quick Leader на панели инструментов Dimension. Запросы команды QLEADER: 
Specify first leader point, or [Settings] <Settings>: – указать первую точку выноски. Specify next point: – указать следующую 
точку выноски; Specify next point: – указать следующую точку выноски; Specify text width <0>: – указать ширину текста; 
Enter first line of annotation text <Mtext>: – ввести первую строку текста пояснения; Enter next line of annotation text: – вве-
сти следующую строку текста пояснения; Enter next line of annotation text: – нажать клавишу Enter для завершения работы 
команды.  

Выноской называется линия, соединяющая на рисунке пояснительную надпись с объектом, к которому она относит-
ся. Выноски и пояснительные надписи ассоциативны, т.е. при редактировании одного из этих объектов соответственно 
изменяется и другой. Выноску, состоящую из прямолинейных или сплайновых сегментов, можно начать от любой точки 
и от любого объекта рисунка. Все свойства выноски, ее цвет, вес линии, масштаб, тип стрелки, размер и прочее опреде-
ляются установкой текущего размерного стиля для первой размерной стрелки. Для связи пояснительной надписи и вы-
носки применяется короткий отрезок, который называется полкой. Полки ставятся в случае, если отклонение от горизон-
тального положения превышает 15°. Для точного указания начальной точки выноски следует использовать объектную 
привязку.  

Пояснительные надписи могут представлять собой многострочные тексты, рамки допусков формы и расположения 
поверхностей или вхождения блоков. Они либо строятся "с нуля", либо копируются из уже существующих пояснений. 
Тексты пояснительных надписей вводятся построчно в командной строке или в диалоговом окне Text Formatting, если 
был введен Enter на запрос Enter first line of annotation text <Mtext>: – ввести первую строку текста пояснения. Параметры 
пояснения, линии-выноски и стрелки, а также способ расположения текста относительно выноски можно задать в диало-
говом окне Leader Settings:  

• на вкладке Annotation, показанной на рис. 55, задается тип пояснения, для которого строится выноска. В качестве 
пояснений могут использоваться многострочный текст, копии объектов, рамки допусков формы и расположения, блоки. 
Параметр Copy an Object позволяет использовать в качестве пояснения уже имеющийся объект, не создавая новый. Здесь 
можно также указать режимы многострочного текста и настроить повторное использование пояснения для последующих 
выносок;  

• на вкладке Leader Line & Arrow, представленной на рис. 56, указывается тип линии-выноски: ломаная Straight или 
сплайновая Spline.  

 

Рис. 54. Простановка  
углового размера 



 

 
Рис. 55. Диалоговое окно параметров выноски 

 
 

Рис. 56. Вкладка выносок и стрелок 
 
 
В области Arrowhead из раскрывающегося списка можно выбрать тип стрелки, а в области Angle Constraints задать 

ограничения углов для сегментов выноски. Чтобы обеспечить быстрое нанесение выносок, можно в области Number of 
Points указать количество точек на выноске; на вкладке Attachment, представленной на рис. 57, выбирается способ распо-
ложения многострочного текста относительно выноски.  

Для загрузки диалогового окна Leader Settings необходимо выбрать из падающего меню пункты Dimension>Leader, а 
затем нажать клавишу Enter.  

 
 

 
Рис. 57. Диалоговое окно параметров выноски, вкладка Attachment 

Быстрое нанесение размеров. Команда QDIM обеспечивает быстрое нанесение 
размеров (рис. 58). Она вызывается из  падающего меню Dimension>QDIM или щелч-
ком мыши по пиктограмме Quick Dimension на панели инструментов Dimension. Запро-
сы команды QDIM: Select geometry to dimension: – выбрать объекты для нанесения раз-
меров; Select geometry to dimension: – выбрать объекты для нанесения размеров; Select 
geometry to dimen-sion: – нажать клавишу Enter по завершении выбора объектов: Specify 
dimension line positionor[Continuous/Staggered/Base-line/Ordinate/Radius/Diameter/datum-
Point/ 
Edit/ SeTt ings] <Continuous>: – указать местоположение размерной линии. Команда 
QDIM запрашивает лишь указание контуров, на которые необходимо проставить разме-
ры, и требует выбрать тип проставляемых размеров путем установки соответствующего 
ключа.  

Рис. 58. Быстрое нанесение  
размеров 



 

1.2.3. Управление размерными стилями 
 

Размерный стиль – это поименованная совокупность значений всех размерных переменных, определяющая вид раз-
мера на рисунке. Команда DIMSTYLE обеспечивает работу с размерными стилями в диалоговом окне Dimension Style 
Manager (рис. 59).  

 
Рис. 59. Диалоговое окно управления  размерными стилями 

 

Команда вызывается из падающего меню Dimension>Style или щелчком мыши по пиктограмме Dimension Style на 
панели инструментов Dimension. Диспетчер размерных стилей позволяет выполнить множество различных задач: 

– создать новый размерный стиль;  
– изменить имеющийся размерный стиль;  
– установить текущий стиль;  
– просмотреть размерные стили рисунка и их свойства;  
– воспользоваться предварительным просмотром размерных стилей;  
– сравнить два размерных стиля или создать перечень всех свойств стиля; 
– переименовать размерные стили;  
– удалить размерные стили.  
Размерные стили задают внешний вид и формат размеров. Они позволяют обеспечить соблюдение стандартов и уп-

рощают редактирование размеров. Размерный стиль определяет следующие характеристики:  
– формат и положение размерных линий, линий-выносок, стрелок и маркеров центра;  
– внешний вид, положение и поведение размерного текста;  
– правила взаимного расположения текста и размерных линий;  
– глобальный масштаб размера;  
– формат и точность основных, альтернативных и угловых единиц;  
– формат и точность значений допусков.  
Для нанесения размера AutoCAD применяет текущий размерный стиль. По умолчанию в качестве такового исполь-

зуется ISO-25 (International Standards Organization), если пользователем не задан иной. Стиль STANDARD создан на ос-
нове стандарта ANSI (American National Standards Institute, США), хотя и не полностью с ним совпадает. Если в рисунке 
используются британские единицы, то стиль STANDARD применяется по умолчанию. Стили DIN (Германия) и JIS 
(Japanese Industrial Standards, Япония) имеются в шаблонах рисунков AutoCAD DIN и JIS.  

 
1.3. РЕДАКТИРОВАНИЕ ЧЕРТЕЖЕЙ 

 
1.3.1. Выбор объектов 

 

Большинство команд редактирования AutoCAD требует предварительного указания объектов для работы с ними [5]. 
Выбранные объекты – один или несколько – называются набором. Он может, например, включать в себя все объекты оп-
ределенного цвета или объекты, расположенные на определенном слое. Такой набор можно создать как до, так и после 
вызова команды редактирования. С одним и тем же набором допустимо производить несколько операций редактирова-
ния. Если установлена системная переменная HIGHLIGHT, выбранные объекты будут подсвечены. После того как вызва-
на одна из команд редактирования, AutoCAD предлагает выбрать объекты. В командной строке появляется запрос: Select 
objects: –выбрать объекты. При этом перекрестье указателя мыши заменяется на прицел выбора. Выбор отдельных объек-
тов производится с помощью мыши или одним из способов, которые описаны в этом разделе. При формировании набора 
можно выбрать последний созданный объект, текущий набор объектов, а также все объекты рисунка. Имеется возмож-
ность добавлять объекты в набор и удалять их оттуда. Различные объекты могут заноситься в набор разными способами. 
Например, для выбора всех объектов области рисунка, кроме нескольких, нужно сначала выделить все объекты, а затем 
удалить из набора те, которые не предназначены для редактирования. Способы и ключи выбора объектов:  

Add – включает режим добавления для пополнения существующего набора. Это начальный режим, устанавливае-
мый для выбора объектов;  

ALL – позволяет выбрать все примитивы, в том числе те, которые расположены на отключенных, заблокированных 
и замороженных слоях;  

AUto – выделяет объект, на который установлен указатель мыши. Если не было выбрано ни одного объекта, указан-
ная точка становится первым углом рамки;  



 

BOX – задает прямоугольник по двум точкам. Если вторая точка находится справа от первой, процесс выбора анало-
гичен выбору рамкой Window, а если слева – выбору секущей рамкой Crossing;  

Crossing – секущая рамка выделяет все объекты, которые находятся внутри или пересекают контур рамки. По умол-
чанию в ответ на запрос Select objects: можно указать первый угол рамки, а затем второй в направлении справа налево. 
Для того чтобы объект можно было выбрать, он должен быть хотя бы частично видимым. При выборе секущей рамкой в 
командной строке появляются запросы:  

Select ob jects: С – переход в режим выбора объектов с помощью секущей рамки; Specify first corner: – указать пер-
вый угол рамки; Specify opposite corner: – указать другой угол рамки;  

СPolygon – позволяет выбрать объекты как полностью заключенные в многоугольник, так и пересекающие его гра-
ницу. Область задается путем указания точек вокруг объектов, которые следует выбирать. Многоугольник строится по 
мере установки этих точек; он может быть любой формы, но без самопересечений, и автоматически замыкается при ука-
зании каждой новой вершины. От последней заданной точки до указателя мыши протянута "резиновая нить". При этом в 
командной строке появляются запросы:  

Select objects: CP – переход в режим выбора объектов с помощью многоугольника; First polygon point: – указать пер-
вую точку многоугольника; Specify endpoint of line or [Undo]: – указать конечную точку отрезка; Specify endpoint of line or 
[Undo]: – указать конечную точку отрезка; Specify endpoint of line or [Undo]: – нажать клавишу Enter для завершения вы-
бора объектов с помощью многоугольника; 

Fence – выбирает только объекты, которые пересекает линия. В отличие от рамочного или секущего многоугольника 
она может пересекать саму себя. При указании точек генерируется линия выбора и "резиновая нить" протягивается к пе-
рекрестью графического курсора. При этом в командной строке появляются запросы:  

First fence point: – указать первую точку линии; Specify endpoint of line or [Undo]: – указать конечную точку отрезка; 
Specify endpoint of line or [Undo]: – указать конечную точку отрезка; Specify endpoint of line or [Undo]: – нажать клавишу 
Enter для завершения выбора объектов  

Group – выбирает все объекты внутри заданной группы; 
Last – выбирает последний нарисованный объект, видимый на экране; Multiple – одновременно выбирает несколько 

объектов. Процесс выбора не считается законченным до тех пор, пока на очередной запрос выбора объекта не нажата 
клавиша Enter или пробел;  

Previous – выбирает текущий набор объектов;  
Remove – устанавливает режим удаления указанных объектов из набора;  
Single – устанавливает режим выбора единственного объекта. Когда указан один объект или одна группа, выбор счи-

тается законченным и запрос выбора объектов не повторяется;  
Undo – отменяет (удаляет) последний добавленный в набор объект;  
Window – выбирает объекты, которые целиком попадают в рамку. По умолчанию в от-

вет на запрос Select objects: можно указать первый угол рамки, а затем второй угол по диаго-
нали от первого в направлении слева направо;  

WPolygon – аналогичен режиму Window, но при этом позволяет выбрать объекты, со-
держащиеся внутри области, границы которой составляет многоугольник.  

Если системная переменная PICKDRAG включена, определение рамки произво-
дится при нажатой левой кнопке мыши. Если PICKDRAG отключена (такова настройка 
по умолчанию), то рамка задается двумя нажатиями кнопки мыши в первой и второй 
точках. Очень трудно выбирать объекты, которые лежат близко или непосредственно 
друг на друге. Для этой цели удобнее пользоваться мышью, одновременно удерживая 
нажатой клавишу Ctrl: в результате включается режим циклического перебора, когда по 
щелчку мыши объекты выбираются один за другим, до тех пор, пока не будет выделен 
требуемый. Для управления процессом выбора объектов (рис. 60) необходимо загру-
зить из падающего меню Tools>Options диалоговое окно Options. Задать метод сорти-
ровки объектов можно на вкладке User Preferences. Режим выбора объектов и размер 
прицела определяются на вкладке Selection, показанной. Подробнее об этом рассказы-
вается в разделе "Настройка рабочей среды AutoCAD". 
 
 

1.3.2. Применение фильтр-списков 
 

Существует возможность ограничить выбираемый набор объектов такими свойствами, как цвет, слой и тип объекта 
и прочими путем использования функции быстрого выбора или фильтра списков. Например, можно выбрать на рисунке 
только окружности красного цвета или, наоборот, выбрать все объекты, кроме окружностей красного цвета. Функция 
быстрого выбора Quick Select позволяет сформировать набор объектов по заданному критерию отбора. В диалоговом ок-
не Object Selection Filters задаются и сохраняются для дальнейшего применения различные фильтры выбора объектов. 
При фильтрации распознаются только цвета, типы линий и веса линий, явно присвоенные объектам, но не унаследован-
ные по слою. Например, объект может быть красным, потому что для него задан цвет ByLayer, а слою присвоен красный 
цвет. Следовательно, фильтр должен учитывать также объекты, расположенные на слое, которому присвоен красный цвет, и 
имеющие цвет ByLayer, а не красный. В частично загруженных рисунках функция Quick Select не учитывает незагруженные 
объекты.  

Для формирования набора объектов с помощью функции быстрого выбора следует выбрать из падающего меню 
Tools>Quick Select... и в открывшемся диалоговом окне Quick Select установить необходимые параметры. 

Рис. 60. Диалоговое окно 
быстрого выбора 



 

Для настройки более сложных фильтров и сохранения их под заданными именами достаточно в ответ на запрос 
Select objects: ввести filter и в диалоговом окне Object Selection Filters, показанном на рис. 61, определить фильтр-список. 

 

 
 

Рис. 61. Диалоговое окно определения фильтр-списков 
1.3.3. Удаление и восстановление объектов 

 

Команда ERASE осуществляет удаление (стирание) объектов (рис. 62). Она вызывается из падающего меню 
Modify>Erase или щелчком мыши по пиктограмме Erase на панели инструментов Modify. Запросы команды ERASE: Select 
objects: – выбрать объекты; Select objects: – нажать клавишу Enter для завершения работы команды. Выбор объектов, кото-
рые следует стереть, может производиться любым из доступных способов. Для восстановления удаленных последней ко-
мандой ERASE объектов используется команда OOPS; ее название – "ОЙ" – весьма удачно отражает эмоции пользователя, 
испытываемые в момент применения этой команды.  

 
 
 
 
 
 

1.3.4. Перемещение объектов 
 

 

Команда MOVE осуществляет перемещение объектов (рис. 63). Она вызывается из падаю-
щего меню Modify>Move или щелчком мыши по пиктограмме Move на панели инструментов 
Modify.  

Запросы команды MOVE: Select objects: – выбрать объекты; Select objects: – нажать клави-
шу Enter по завершении выбора объектов; Specify base point or displacement: – указать базовую 
точку или перемещение; Specify second point of displacement or<use first point as displacement: – 
указать новое положение базовой точки.  

 
1.3.5. Поворот объектов 

 

Команда ROTATE осуществляет поворот объектов (рис. 64). Она 
вызывается из падающего меню Modify>Rotate или щелчком мыши по 

пиктограмме Rotate на панели инструментов Modify. Запросы команды ROTATE: Current 
positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0 – текущие установки отсчета уг-
лов в ПСК Select objects: – выбрать объекты; Select objects: – нажать клавишу Enter по заверше-
нии выбора объектов; Specify base point: – указать базовую точку поворота; Specify rotation 
angle or [Reference]: – указать угол поворота. Ключ Reference используется для поворота отно-
сительно существующего угла. При этом выдаются следующие запросы: Current positive angle 
in UCS: ANGDIR=counterclockwise ANGBASE=0 – текущие установки отсчета углов в ПСК; 
Select objects: – выбрать объекты; Select objects: – нажать клавишу Enter по завершении выбо-
ра объектов; Specify base point: – указать базовую точку поворота; Specify rotation angle or [Reference]: R – переход в ре-
жим задания угла со ссылкой; Specify the reference angle <0>: – указать опорный угол; Specify the new angle: – указать но-
вый угол.  

 
1.3.6. Копирование объектов 

 

Команда COPY осуществляет копирование объектов (рис. 65). Она вызывается из падающего меню Modify>Сору 
или щелчком мыши по пиктограмме Сору на панели инструментов Modify. 

 

 
Рис. 65. Копирование объектов 

Рис. 62. Удаление 
объектов 

Рис. 63.  
Перемещение 
объектов 

Рис. 64. Поворот  
объектов 



 

 
Запросы команды COPY: Select objects: – выбрать объекты Select objects: – нажать клавишу Enter по завершении вы-

бора объектов; Specify base point or displacement, or [Multiple]: – указать базовую точку; Specify second point of 
displacement or<use first point as displacement: – указать положение копии объекта. Ключ Multiple используется для созда-
ния множества копий объектов. При его применении последний запрос, требующий указания точки смещения, делается 
многократно. Каждое смещение определяется относительно исходной базовой точки. После получения нужного числа 
копий в ответ на запрос необходимо нажать клавишу Enter. 

 
1.3.7. Размножение объектов массивом 

 

Команда ARRAY осуществляет размножение объектов массивом. Она вызывается из падающего меню 
Modify>Array... или щелчком мыши по пиктограмме Array на панели инструментов Modify. При этом открывается диало-
говое окно Array, где можно настроить следующие параметры:  

– режим установки значений прямоугольного массива Rectangular Array (рис. 66):  
– в полях Rows: и Columns: указывается количество рядов и столбцов массива; в области Offset distance and.direction, 

в полях Row offset:, Columns offset: и Angle of array:, задаются расстояния между рядами и столбцами массива, а также 
угол поворота элемента.  

 
Рис. 66. Диалоговое окно формирования прямоугольного массива 

 
Расстояния можно ввести с клавиатуры в соответствующих полях или мышью, для чего необходимо воспользовать-

ся кнопками Pick Both Offset – указать оба расстояния; Pick Row offset – указать расстояние между рядами и Pick Column 
offset – указать расстояние между столбцами; режим установки значений кругового массива Polar Array (рис. 67); 

– в строке Center Point:, в полях X: и Y:, указываются соответствующие координаты центра массива. Для того чтобы 
ввести центр при помощи мыши, следует воспользоваться кнопкой Pick Center Point;  

 

 
 

Рис. 67. Диалоговое окно формирования кругового массива 
– в раскрывающемся списке способов построения Method: выбирается один из параметров: Total number of items & 

Angle to fill – число элементов и угол заполнения; Total number of items & Angle between items – число элементов и угол 
между элементами либо Angle to fill & Angle between items – угол заполнения и угол между элементами;  

– в зависимости от выбранного способа построения активируются два поля из следующих трех: Total number of 
items: – число элементов; Angle to fill: – угол заполнения; Angle between items: – угол между элементами;  

– установкой флажка Rotate items as copied назначается поворот элемента массива вокруг своей оси. Базовую точку 
при желании можно указать в соответствующих полях, для чего понадобится развернуть окно щелчком по кнопке More;  

– кнопка Select objects служит для выбора элементов массива;  



 

– результат работы команды можно оценить, нажав кнопку Preview или просмотрев его на схеме справа в диалого-
вом окне. 

1.3.8. Зеркальное отображение объектов 
 

Команда MIRROR осуществляет зеркальное отображение объектов (рис. 68). Она вы-
зывается из падающего меню Modify>Mirror или щелчком мыши по пиктограмме Mirror на 
панели инструментов Modify. Запросы команды MIRROR: Select objects: – выбрать объек-
ты; Select objects: – нажать клавишу Enter по завершении выбора объектов; Specify first point 
of mirror line: – указать первую точку оси отражения; Specify second point of mirror line: – 
указать вторую точку оси отражения; Delete source objects – указать: удалить или оставить. 
При зеркальном отображении тексты, атрибуты и их определения также приобретают зер-
кальный вид. Это происходит из-за того, что операция зеркального отображения выполня-
ется в строгом соответствии с математическими законами отражения. Чтобы полученный в 
результате зеркального отображения текст имел привычный вид, следует присвоить сис-
темной переменной MIRRTEXT значение 0. По умолчанию эта переменная включена. Если 
же ее отключить, отображенный текст будет ориентирован и выровнен точно так же, как и 
исходный. При этом команда MIRROR особым образом обрабатывает элементы текста и примитивы атрибутов, отобра-
жая их в прежней ориентации. Переменная MIRRTEXT воздействует только на простые объекты текста, созданные ко-
мандами TEXT, DTEXT, МТЕХТ, а также на определения атрибутов и их переменные, не входящие внутрь вставленного 
блока. Тексты и постоянные атрибуты внутри блока отражаются, как и все составляющие блока, зеркально, независимо 
от установки системной переменной MIRRTEXT.  

 
1.3.9. Создание подобных объектов 

 

Команда OFFSET осуществляет создание подобных объектов (эквидистант) с заданным 
смещением (рис. 69). Она вызывается из падающего меню Modify>Offset или щелчком мыши 
по пиктограмме Offset на панели инструментов Modify. Можно строить подобные отрезки, 
дуги, окружности, двумерные полилинии, эллипсы, эллиптические дуги, прямые, лучи и пло-
ские сплайны. Подобные окружности имеют диаметр, больший или меньший, чем исходный, 
в зависимости от того, как задано смещение. Если оно указано точкой вне окружности, то 
новая окружность имеет больший диаметр, а если внутри окружности, – меньший. Запросы 
команды OFFSET: Specify offset distance or [Through] <Through>: – указать величину смеще-
ния; Select object to offset or <exit>: – выбрать объект для создания подобных; Specify point on 
side to offset: – указать точку, определяющую сторону смещения; Select object to offset or 
<exit>: – нажать клавишу Enter для завершения работы команды. Ключ Through позволяет 
задать смещение через точку. При этом выдаются следующие запросы: Specify offset distance 
or [Through] <default>: Т –переход в режим указания смещения через точку; Select object to 
offset or <exit>: – выбрать объект для создания подобных Specify through point: – указать точ-

ку; Select object to offset or <exit>: – нажать клавишу Enter для завершения работы команды. Значение текущей величины 
смещения хранит системная переменная OFFSETDIST. Переменная OFFSETGAPTYPE управляет способом создания по-
добных полилиний, если при смещении образуется зазор между отдельными сегментами полилинии.  

 
1.3.10. Масштабирование объектов 

 

Команда SCALE осуществляет масштабирование объектов (рис. 70). Она вызыва-
ется из падающего меню Modify>Scale или щелчком мыши по пиктограмме Scale на 
панели инструментов Modify. Запросы команды Scale: Select objects: – выбрать объек-
ты; Select objects: – нажать клавишу Enter по завершении выбора объектов; Specify 
base point: – указать базовую точку; Specify scale factor or [Reference]: – указать коэф-
фициент масштабирования. При масштабировании объектов масштабные коэффици-
енты по осям X и Y одинаковы. Таким образом, можно делать объект больше или 
меньше, но нельзя изменять соотношение его размеров по этим осям. Масштабирова-
ние выполняется путем указания базовой точки и новой длины объекта, из которой 
выводится масштабный коэффициент для текущих единиц, или путем явного ввода 
коэффициента. Кроме того, коэффициент может определяться путем указания теку-
щей длины и новой длины объекта. При масштабировании с указанием масштабного 
коэффициента производится изменение размеров выбранного объекта во всех измерениях. Если масштабный коэффици-
ент больше единицы, то объект увеличивается, а если меньше единицы – уменьшается. Ключ Reference применяется для 
определения коэффициента масштабирования с использованием размеров существующих объектов в качестве ссылок. 
При этом выдаются следующие запросы: Select objects: – выбрать объекты; Select objects: – нажать клавишу Enter по за-
вершении выбора объектов; Specify base point: – указать базовую точку; Specify scale factor or [Reference]: R – переход в 
режим указания масштабного коэффициента со ссылкой; Specify reference length <1>: – указать длину опорного отрезка; 
Specify new length: – указать новую длину. Один из наиболее эффективных вариантов использования ключа Reference – 
изменение масштаба всего рисунка. Если оказалось, что выбранные единицы рисунка не соответствуют заданным требова-
ниям, то для выбора всех объектов на чертеже (например, при помощи рамки) можно воспользоваться командой SCALE, а 
затем, применяя ключ Reference, указать два конца объекта, требуемая длина которого известна, и ввести данную длину. 
При этом масштаб всех объектов на рисунке изменится соответствующим образом.  

Рис. 68. Зеркальное  
отображение объектов 

Рис. 69. Построение 
эквидистанты 

Рис. 70. Масштабирование 
объектов 



 

 
1.3.11. Растягивание объектов 

 

Команда STRETCH осуществляет растягивание объектов, сохраняя при этом связь с ос-
тальными частями рисунка (рис. 71). Вызывается она из падающего меню Modify>Stretch 
или щелчком мыши по пиктограмме Stretch на панели инструментов Modify. Запросы ко-
манды STRETCH: Select objects to stretch by crossing-window or crossing-polygon – выберите 
растягиваемые объекты секущей рамкой или секущим многоугольником; Select objects: – 
выбрать объекты; Select objects: – нажать клавишу Enter по завершении выбора объектов; 
Specify base point or displacement: – указать базовую точку; Specify second point of 
displacement or<use first point as displacement: – указать новое положение базовой точки. 
Формирование набора объектов для этой команды должно производиться с ключом секущей 
рамки Crossing или Cpolygon. Любые объекты, полностью заключенные в рамку или много-

угольник, перемещаются командой STRETCH точно так же, как командой MOVE. Отрезки, дуги и сегменты полилиний, 
пересекающие рамку, растягиваются только путем перемещения конечных точек, находящихся внутри нее: конечные 
точки за рамкой остаются неизменными. В дугах центральная точка и ее начальный и конечный углы регулируются та-
ким образом, что стрелка дуги (расстояние от центральной точки хорды до дуги) поддерживается постоянной. Команда 
STRETCH не влияет на ширину полилиний, на информацию о сопряжениях и углах касания. Вершины полос и фигур, 
находящиеся внутри рамки, также перемещаются, тогда, как вершины за пределами рамки остаются на месте. Другие 
примитивы перемещаются или остаются на месте в зависимости от того, находится ли определяющая их точка внутри 
рамки. Определяющими точками являются центр круга, точка вставки формы или блока (если точка вставки блока пере-
мещается командой STRETCH, то перемещаются и все его атрибуты), крайняя левая точка базовой линии для текста и 
для определения атрибута – независимо от типа выравнивания, использованного при вычерчивании элемента. Если ко-
манда STRETCH вызывается при действующем предварительном наборе, то для рассмотрения определяющих точек, 
подпадающих под действие используются только примитивы, выбранные с помощью обычной или секущей рамки.  

 
1.3.12. Удлинение объектов 

 

Команда EXTEND, которая осуществляет удлинение объектов до граничной кромки (рис. 
72), вызывается из падающего меню Modify> Extend или щелчком мыши по пиктограмме Extend 
на панели инструментов Modify. Запросы команды EXTEND: Current settings: Projection=UCS 
Edge=None – текущие установки проекции и кромки; Select boundary edges  – выбрать граничные 
кромки; Select objects: – выбрать объекты; Select objects: – нажать клавишу Enter по завершении вы-
бора граничной кромки; Select object to extend or shift-select to trim or [Project/ Edge/Undo]: – вы-
брать удлиняемый объект; Select object to extend or shift-select to trim or [Project/Edge/ Undo]: – на-
жать клавишу Enter для завершения работы команды.  

Для удлинения полилиний можно использовать только разомкнутые. Смысл этой операции 
заключается в том, что первый или последний сегмент полилинии удлиняется так, как если бы 
он был одиночным отрезком или дугой. При удлинении широкой полилинии граничная кромка 
соприкасается с ее осевой линией. Поскольку торцевой срез широкой полилинии проводится под 

углом 90°, то, если граничная кромка не перпендикулярна удлиняемому сегменту, конец полилинии частично заходит за 
кромку. При удлинении конусного сегмента конечная ширина сегмента корректируется так, чтобы текущая конусность 
оставалась неизменной. Если в результате получается отрицательная конечная ширина, она устанавливается равной 0. 
Допускается удлинение лучей, но удлинение прямых невозможно. Так же как и окружность, прямая линия не имеет гра-
ничной кромки и конечной точки. Луч является полуограниченным объектом, поэтому его можно удлинить до новой на-
чальной точки. Имеется возможность изменять центральные углы дуг и длин некоторых объектов. В частности, допуска-
ется изменение длины разомкнутых последовательностей отрезков, дуг, разомкнутых полилиний, эллиптических дуг и 
разомкнутых сплайнов. В зависимости от ситуации этот процесс подобен либо удлинению, либо обрезке. Изменение 
длины может производиться различными способами:  

1) динамически – буксировкой конечной точки объекта;  
2) указанием новой длины в процентном отношении к текущей длине или углу;  
3) указанием приращения длины или угла, откладываемого от конечной точки;  
4) установкой полной абсолютной длины объекта или его цент-рального угла.  
Граничными кромками могут служить отрезки, дуги, двухмерные полилинии. Когда в качестве кромки используется 

двумерная полилиния, ее ширина игнорируется и объекты удлиняются до ее осевой линии. Удлиняемые объекты выби-
раются путем указания той части, которая должна удлиняться. Объекты нельзя выделять рамкой, секущей рамкой или 
объявлять последним набором; допустимы только прямое указание, ввод координат и выбор линией. Ключи команды 
EXTEND:  

Project – определяет режим удлинения объектов до пересечения их проекции с границей в трехмерном пространстве:  
None – удлинение только тех объектов, которые пересекаются с заданной границей;  
Ucs – определение проекции объекта в плоскости XY текущей ПСК и удлинение объекта, не пересекающегося с гра-

ницей;  
View – определение проекции объекта в направлении заданного вида и удлинение объекта, не пересекающегося с 

границей;  
Edge – определяет режим поиска пересечения:  
Extend – удлинение объекта до воображаемой продолженной границы; 

Рис. 71. Растягивание 
объектов 

Рис. 72. Удлинение 
объектов 



 

No extend– удлинение объектов до границы без ее удлинения.  
Если задано несколько граничных кромок, объект удлиняется до тех пор, пока не достигнет первой из них. Этот же 

объект можно выбрать вновь, чтобы удлинить его до следующей граничной кромки.  
 

1.3.13. Разбиение объектов на части 
 

Команда BREAK, которая осуществляет разрыв объектов (рис. 73), вызывается из падаю-
щего меню Modify>Break или щелчком мыши по пиктограмме Break на панели инструментов 
Modify. Запросы команды BREAK: Select object: – выбрать объект; Specify second break point or 
[First point]: – указать вторую точку разрыва. В зависимости от используемых ключей, разрыв 
можно осуществить без стирания или со стиранием части отрезка, окружности, дуги, двухмер-
ной полилинии, эллипса, сплайна, прямой или луча. Для разбиения объекта можно либо выбрать 
объект в первой точке разрыва, а затем указать вторую точку разрыва, либо вначале просто вы-
брать объект, а затем произвести указание двух точек разрыва.  

 
 

 
 

1.3.14. Обрезка объектов 
 

Команда TRIM, которая осуществляет отсечение объектов по режущей кромке (рис. 74), вызывается из падающего 
меню Modify>Trim или щелчком мыши по пиктограмме Trim на панели инструментов Modify. Запросы команды TRIM: 
Current settings: Projection = UCS Edge = None – текущие установки проекци и кромки; Select cutting edges: – выберите 
режущие кромки; Select objects: – выбрать объекты, являющиеся режущей кромкой; Select objects: – нажать клавишу Enter 
по завершении выбора режущей кромки; Select object to trim or shift-select to extend or [Project/Edge/Undo]: – выбрать об-
резаемый объект; Select object to trim or shift-select to extend or [Project/Edge /Undo]: – нажать клавишу Enter для завершения 
работы команды. Секущей кромкой могут служить отрезки, дуги, окружности, двухмерные полилинии, эллипсы, сплайны, 
прямые, лучи. Объект, не пересекающийся с секущей кромкой, можно отсечь в месте их воображаемого пересечения. Когда 

секущая кромка определяется двухмерной полилинией, ее ширина не учитывается и обрезка про-
водится по осевой линии.  

В пространстве листа секущими кромками могут служить границы видовых экранов. 
Ключи команды TRIM:  

Project – определяет режим отсечения объектов по пересечению их проекции с границей в 
трехмерном пространстве;  

None – отсечение только тех объектов, которые пересекаются с заданной границей;  
Ucs – определение проекции объекта в плоскости XY текущей ПСК и отсечение объекта, 

не пересекающегося с границей;  
View – определение проекции объекта в направлении заданного вида и отсечение объекта, 

не пересекающегося с границей;  
Edge – определяет режим поиска пересечения:  
Extend – отсечение объекта по воображаемой продолженной границе;  
No extend – отсечение объектов по границе, с которой они имеют пересечение.  

 
1.3.15. Расчленение объектов 

 
Команда EXPLODE осуществляет расчленение блоков на составляющие их примитивы. Команда вызывается из па-

дающего меню Modify>Explode или щелчком мыши по пиктограмме Explode на панели инструментов Modify. Запросы 
команды EXPLODE: Select objects: – выбрать объекты; Select objects: – нажать клавишу Enter по окончании выбора объ-
ектов и для завершения работы команды. При расчленении блока изображение на экране получается идентичным исход-
ному, но при этом цвет, тип и вес линии объектов могут изменяться. Так, у объектов, входивших в блок, после его рас-
членения восстанавливаются исходные свойства. Если расчленению подвергнута двухмерная полилиния, то любая ин-
формация о ширине или касательной игнорируется, получаемые отрезки и дуги следуют по осевой линии полилинии. По 
завершении работы команды EXPLODE применительно к полилинии, имеющей ширину, отличную от нуля, будет выда-
но сообщение о том, что при ее расчленении потеряны сведения о ширине: Exploding this polyline has lost width 
information. The UNDO command will restore it. Действие команды EXPLODE в каждый момент распространяется только 
на один уровень вложенности. Это значит, что если блок содержит полилинию, то при его расчленении появится цельная 
полилиния. Если потребуются отдельные дуговые или линейные сегменты, полилинию надо будет расчленить отдельно. 
Расчленение блоков, вставленных с неравными масштабными коэффициентами по осям X, Y и Z, может привести к самым 
неожиданным последствиям. Внешние ссылки и связанные с ними блоки расчленить нельзя. При расчленении из блоков 
удаляются атрибуты, однако их исходные описания при этом сохраняются. 

Рис. 73. Разбиение 
объектов на части 

Рис. 74. Обрезка  
объектов 



 

1.3.16. Снятие фасок 
 

Команда CHAMFER осуществляет снятие фасок на объектах (рис. 75). Команда вызывается из падающего меню 
Modify>Chamfer или щелчком мыши по пиктограмме Chamfer на панели инструментов Modify. Запросы команды 
CHAMFER: (TRIM mode) Current chamfer Distl = 10.0000, Dist2 = 10 0000 – режим с обрезкой, параметры фаски; Select 
first line or [Polyline/Distance/Angle/Trim/Method/multiple]: – выбрать первый отрезок; Select second line: – выбрать второй 
отрезок.  

 

 
 

Рис. 75. Снятие фасок 
 
Процесс снятия фасок заключается в соединении двух непараллельных объектов путем их удлинения или обрезки до 

пересечения либо друг с другом, либо с линией фаски. Снятие фасок можно выполнять для отрезков, полилиний, прямых 
и лучей. При установке фаски методом длин указываются расстояния, на которые каждый объект нужно удлинить или 
обрезать. При установке фаски методом угла также можно указать длину линии фаски и угол, образуемый ею с первой 
линией. Соединяемые объекты либо оставляют в том виде, который они имели до снятия фаски, либо обрезают или удли-
няют, используя линию фаски в качестве кромки. Если оба соединяемых объекта лежат на одном слое, линия фаски про-
водится на нем же. В противном случае она располагается на текущем слое. То же справедливо в отношении цвета, типа 
и веса линии фаски. Если точка пересечения объектов находится за лимитами рисунка, а опция контроля лимитов вклю-
чена, то снятие фаски не выполняется. Ключи команды CHAMFER:  

Polyline – снятие фасок вдоль всей полилинии, т.е. в каждом пересечении ее сегментов. При этом обрабатываются 
только те сегменты, длины которых превосходят длину фаски. Построенные вдоль полилинии фаски становятся ее новы-
ми сегментами, даже если их длина равна нулю;  

Distance – настройка длины фаски, т.е. расстояния между точкой реального или воображаемого пересечения объек-
тов и точкой, до которой удлиняется или обрезается объект при снятии фаски. Если обе длины фаски равны нулю, то 
объекты обрезаются или удлиняются до точки их пересечения, а линия фаски не строится. 

В качестве значения первой длины фаски по умолчанию выступает последняя заданная длина. Значение второй дли-
ны по умолчанию совпадает со значением первой длины, так что стандартными считаются симметричные фаски, хотя 
значения по умолчанию можно изменить. Величины первой и второй длин запоминаются в файле рисунка. Исходные 
длины фасок нового рисунка определяет шаблон. При использовании ключа Distance выдаются следующие запросы: 
TRIM mode) Current chamfer Distl = 0.0000, Dist2 = 0.0000 – режим с обрезкой, параметры фаски Select first line 
or.[Polyline/Distance/Angle/Trim/Method/multiple]: D – переход в режим настройки длины фаски Specify first chamfer 
distance<default>: – указать первую длину фаски Specify second chamfer distance<default>: – указать вторую длину фаски;  

Angle – позволяет задать длину для первой линии и угол относительно первой линии для подрезания второй;  
Trim – позволяет определить, следует ли обрезать линии до снятия фаски. Если следует, то первая линия отсекается 

на величину первого расстояния, а вторая линия – на величину второго. Если расстояние равно нулю, то происходит под-
гонка в одну точку. По умолчанию соединяемые фаской объекты обрезаются;  

Method – позволяет выбрать один из методов установки размеров фасок: либо расстояниями, либо расстоянием и уг-
лом.  

 
1.3.17. Рисование округлений 

 

Команда FILLET осуществляет плавное скругление (сопряжение) объектов (рис. 76). Она вызывается из падающего 
меню Modify>Fillet или щелчком мыши по пиктограмме Fillet на панели инструментов Modify. Запросы команды FILLET: 
Current settings: Mode = TRIM, Radius = 10.0000 – текущие настройки: режим, радиус сопряжения; Select first object or 
[Polyline/Radius/Trim/mUltiple]: – выбрать первый объект; Select second object: – выбрать второй объект.  

 

 
Рис. 76. Сопряжение объектов 



 

Сопряжением называется плавное соединение двух объектов дугой заданного радиуса. AutoCAD не делает различия 
между внутренними и внешними сопряжениями. Если оба сопрягаемых объекта лежат на одном слое, линия сопряжения 
проводится на нем же. В противном случае она располагается на текущем слое.  

Сказанное справедливо для цвета, типа и веса линии сопряжения. Можно сопрягать пары отрезков, линейные (но не 
дуговые) сегменты полилиний, прямые, лучи, круги, дуги и реальные (т.е. не многоугольные) эллипсы. Сопряжение от-
резков, прямых и лучей применимо даже к параллельным объектам. Сопряжения в вершинах полилинии производятся 
друг за другом по одному. Сопрягать можно отрезки и полилинии в любых комбинациях, а также все твердотельные объ-
екты. Допускается сопряжение отрезка и окружности, отрезка и дуги или окружности и дуги. Правила скругления в этом 
случае такие же, как при сопряжении отрезков. Однако в случае с дугами и окружностями возможно построение более 
одной дуги сопряжения. AutoCAD выберет сопряжение, конечные точки которого ближе всего к точкам выбора объектов 
для скругления. Для плавного соединения с дугой сопряжения отрезки и дуги могут обрезаться или удлиняться.  

Отсекаемый фрагмент – это та часть на стороне дуги сопряжения, которая образует точку пересечения с исходным 
объектом. Такая логика гарантирует плавность скругления и обычно совпадает с интуитивным представлением, согласно 
которому сохраняется та часть, которая указана. Окружности никогда не обрезаются, при этом дуга сопряжения плавно 
соединяется с окружностью.  

Ключи команды FILLET: Polyline означает, что операция сопряжения выполняется со всей полилинией.  
 



 

2. ИНДИВИДУАЛЬНЫЕ ЗАДАНИЯ ПО КУРСУ 
КОМПЬЮТЕРНОЙ ГРАФИКИ 

 

 
 

Во время изучения курса по начертательной графике студенты должны выполнить два индивидуальных задания в 
соответствии со своим вариантом. Каждое задание включает 16 вариантов. Каждый вариант состоит из двух задач на по-
строение по аксонометрической проекции модели ее чертежей в трех проекциях. 

Задача 1 – с применением фронтального разреза. Задача 2 – с применением горизонтального разреза. 
 

Лабораторная работа 1 
 

ВЫПОЛНЕНИЕ ЧЕРТЕЖЕЙ ПО АКСОНОМЕТРИЧЕСКИМ  
ПРОЕКЦИЯМ МОДЕЛЕЙ С ПРИМЕНЕНИЕМ РАЗРЕЗОВ НА ПЭВМ В СИСТЕМЕ AUTOCAD 

 

Цель работы: овладение практическими навыками работы на ПЭВМ в графической системе AutoCAD. 
 
Задание 
По аксонометрическим проекциям моделей построить их чертежи с применением разрезов. Пример выполнения 

приведен на рис. 77 [6, 7]. Варианты индивидуальных заданий к лабораторной работе 1 приведены на страницах 62 – 65. 
 

Лабораторная работа 2 
 

ПОСТРОЕНИЕ ПО ДВУМ ПРОЕКЦИЯМ МОДЕЛИ 
ЕЕ ТРЕТЬЕЙ ПРОЕКЦИИ С ПРИМЕНЕНИЕМ РАЗРЕЗОВ НА ПЭВМ В СИСТЕМЕ AUTOCAD 

 

Цель работы: совершенствование практических навыков работы в графической системе AutoCAD. 
 
Задание 
По двум проекциям моделей построить ее третью проекцию  с применением и нанесением указанных размеров, по-

строить изометрическую проекцию с вырезом передней четверти. Пример выполнения приведен на рис. 78 [8, 9]. Вариан-
ты индивидуальных заданий к лабораторной работе 2 приведены на страницах 66 – 73. 



 

 
 

Рис. 77.  Образец выполнения лабораторной работы 1 



 

 
 
 

Рис. 78.  Образец выполнения лабораторной работы 2



 

Варианты индивидуальных заданий к  
лабораторной работе 1   

 



 



 



 



 

Варианты индивидуальных заданий к  
лабораторной работе 2 

 

 



 



 



 



 



 



 



 



 

ЗАКЛЮЧЕНИЕ 
 

 
 

Графические CAD системы позволяют разрабатывать чертежи в различных областях проектной деятельности. Ис-
пользование программных продуктов в учебном процессе технологического факультета требует особого подхода с уче-
том указанных выше факторов. При этом некоторые "избыточные" для учебного процесса функции систем, превышаю-
щие достаточный теоретический и практический объем знаний и умений, могут не изучаться. 

Освоение студентами технических вузов компьютерной техники и программных графических продуктов позволяет: 
– повысить уровень подготовки кадров для различных отраслей промышленности; 
– ускорить процесс выполнения и улучшить качество учебных графических работ; 
– использовать полученные знания и умения для разработки курсовых и дипломных работ. 
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